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Introduction to Assembly Modeling
In DesignWave, working with an assembly is the same as working with a part. An assembly is simply a part that 
references other parts that, in turn, may reference other parts. The component and product structure browsers 
provide a logical breakdown of the structure of your assembly. To enhance visibility, you can hide components or 
change their color. With mating conditions, you can constrain the position of a component relative to the other 
components in the assembly. These relative positions are maintained as components move, change size, or change 
shape.

Designing in Teams

With DesignWave, you can design in teams. That is, you can work on the assembly while others work on the 
individual piece parts that the assembly references. You can work on a piece part by itself or in the context of an 
assembly. When a part is opened in context. All of the other parts in the assembly are displayed in a light gray 
color. You can use their geometry to add new features to the open part. When you change a part (component), 
those changes are automatically propagated to the assembly. If you have the assembly open, you see your 
changes immediately. If not, you will see your changes the next time you open the assembly.

See Also
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Adding Components
When you add a component to an assembly, the contents of the component part file are not copied into the 
assembly. Instead, the assembly references its contents. When you make changes to that component, those 
changes are automatically propagated back to the assembly. You cannot add an assembly as a component to itself.

Components are listed in the Component Browser. 

Component Names

The name of the component is the name of the part. You cannot change the name of a component. You can add 
the same component more than once. If you add the same component more than once, a number is appended to 
the component name. This number distinguishes one occurrence of a component from the others. 

Component Placement

When you add a component to an assembly, it is initially placed so that its base workplane coincides with the active
workplane. To initially place a component at a specific location, you can create a workplane at that location. Then, 
you can move that component to a different location by translating or rotating it or by defining mating conditions.

Search for Part Files

If, after you added the component, you decide to move its part file to another directory, the assembly can still 
reference it. If you move its part file to another directory, the assembly first looks for it in the directory where the 
assembly resides and then in the directories listed in your search path.

See Also
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Creating Mating Conditions
A mating condition is a relationship between two components. The order in which you select the faces or edges 
does not determine which component moves in order to satisfy the mating condition. The younger of the two 
components always moves. Age is determined by the order in which you added the components to the assembly.

Mating conditions let you precisely constrain the position of components relative to the other components in the 
assembly. These relative positions are maintained as components move, change size, or change shape. A 
component is fully constrained if you cannot move or rotate it in any direction without violating a mating condition. 
Especially with complex assemblies, it can be very difficult to fully constrain a component's location. You can 
choose to not constrain, partially constrain, or fully constrain a component's location.

Mating conditions are listed in the Component Browser. They are shown as small green clamp icons underneath the
icon of the component they constrain. Commands on the popup menu let you delete that mating condition or 
highlight the geometry used to define it.

Types of Mating Conditions

There are four different types of mating conditions. Mate and Align Planes make the planar faces that belong to two
different components coincide with each other. A face has two sides. How the components line up with respect to 
each other depends on the command chosen. With Mate Planes, the components oppose each other. With Align 
Planes, they face in the same direction. Mate and align are opposites. If Align Planes does not position a component
as you expect, Mate Planes likely will. You cannot offset either mated or aligned faces from each other. 

Center Axes aligns circular holes or features that belong to two different components. With Center Axes, the axes of 
the circular holes or features will line up with each other. Orient Axes lets you rotate the components about their 
axes. For example, to line up a keyway, the components are rotated so that two selected edges become parallel.

See Also
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Using the Component Browser
The component browser provides a logical overview of the structure of your assembly.

In the Component browser, components are shown with the small yellow rivet icons. The name of the component is
listed after the icon. Except for the first occurrence, a number follows the component name. This number 
distinguishes one occurrence of a component from the others. The first occurrence never has a number. If the 
component is hidden, its icon is shown in an outline form.

Mating conditions are shown with the small green clamp icons underneath the icon of the component that they 
constrain. The type of mating condition (Mate, Align, Center, or Orient) is listed after to each icon. From the popup 
menu, you can delete that mating condition or highlight the geometry used to define it.

From the popup menu, you can select or hide a component. The Select command selects that component in the 
part window. You may even select a hidden component. The Hide command toggles the display of a component on 
and off in the part window. A check mark appears next to the Hide command if the component is hidden.

See Also
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Moving Components
In addition to creating mating conditions, you can place components in the assembly by simply moving or rotating 
them. You move or rotate components in the same way you move or rotate any other object in DesignWave; that 
is, in any direction along the active workplane. 

You can move or rotate components that have mating conditions only in directions that do not violate any of those 
conditions. 

See Also

{button ,AL(`assemblyModeling')}Other topics on assembly modeling



Opening a Design in Context
As you work on a part, the ability to reference features from other components may facilitate the design of that 
part. The Open Part in Context command on the Assembly menu lets you open a part and work on it in the context 
of an assembly. With a part open in context, you can reference geometry from other components as you build new 
features. 

See Also
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Working on a Design in Context
For a part open in context, all of the components including the open part are in the same locations as in the 
assembly. The view is the same. All of the unopened components are displayed in a light gray color to distinguish 
them from the geometry that belongs to the open part. The browsers display the features, workplanes, and 
components that belong to the open part - not those that belong to the assembly.

The part itself can be modified, while the rest of the assembly is read-only. You can reference the edges and faces 
that belong to other components just as if they belonged to the open part, but you cannot change them. Nor, can 
you move any of the components. But, whenever you change the original assembly, those changes are 
automatically reflected in the open part.

See Also
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Using Context Geometry
With a part open in context, you can reference the edges and faces that belong to other components as you design
new features. You can use them just as if they belonged to the open part, but you cannot change them.

You can use the Measure command on the Tools menu to measure the dimensions of other components, and then 
use those measurements in the design of new features. Using a face on another component, you can construct a 
workplane. As you sketch, attraction points on edges that belong to other components highlight. Any reference to 
geometry that belongs to another component is not associative.

For example, you are designing a spur gear that fits around the shaft on another component. You may want to 
create a workplane using the flat face on the end of the shaft. As you sketch the profile for gear, the attraction 
point for the center of the shaft will highlight and you may select it as the center for the hole in the gear. With the 
Measure command, you may determine the diameter of the shaft and set the diameter of the hole in the gear 
equal to it.

See Also
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Creating a New Part in Context
You can use the Open Part in Context command to open any component and work on it in the context of your 
assembly. The command works with any component regardless of whether or not it contains geometry. If you 
create a new, empty part and add it to your assembly, you can open and work on it in the context of your 
assembly.

When you open a new part in the context of an assembly, its base workplane coincides with the workplane that was
active when you added that part to your assembly. In a part, before you add a new feature, you decide where to 
place that feature and you create a workplane at that location. Likewise, before you add a new part to your 
assembly, decide where to place that part and create a workplane at that location. When you open your new part in
context, its base workplane will coincide with that workplane from your assembly.

For example, assume that your new part mates with a face on another component. To facilitate your design, you 
can make the plane of that face the base workplane for your new part.

See Also
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Changing the Color of a Part
The Set Component Color command on the Assembly menu lets you customize the appearance of your assembly. 
When you add a new component, DesignWave assigns it a color. You can, however, change the color to visually 
convey information. For example, you can assign colors based on a component's material type or function. Or, you 
can assign colors to emphasize important components.

All occurrences of a component in an assembly have the same color. When you change the color of one occurrence 
of a component, the color changes in all occurrences.

For a subassembly, a component comprising other components, you can change the color of the individual base 
components. 

See Also
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Hiding Components
A complex assembly may contain many components. Some of those components may obscure your view or 
interfere with your access to other components. You can simplify your assembly by turning off the display of those 
components. The Hide command on the popup menu toggles the display of a component in the part window on and
off. 

An assembly may also contain complex components. You can sometimes hide these components without affecting 
what you are working on. By hiding complex components, you will improve system performance and make more 
efficient use of system resources.

See Also
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Browsing the Product Structure
The product structure browser provides a detailed logical view of the structure of your assembly. Like the Windows 
Explorer, it has two windows. The left window displays a hierarchical breakdown of your assembly. The right 
window displays either a parts-list view or a bill-of-materials view of the component selected in the left window. 

In the left window, you can examine any piece of your assembly structure in any degree of detail. You can examine
and edit any component, or query its mass properties. This lets you quickly focus on those aspects of the assembly
that are important to you. 

The right window displays any component in your assembly from one of two different perspectives. The parts-list 
view lists those components that you added in creating the selected component. The bill-of-materials view lists 
those components necessary to build the selected component. These are the components that contain geometry 
not those that are simply composed of other components. 

The name, quantity, and file name are displayed for each component. You can sort the list of components by name,
quantity, or file name. You can, optionally, exclude hidden components from the list or save the list of components 
as a comma-separated value file that you can later input into a spreadsheet application.

See Also
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Analyzing Your Assembly

Measuring Lengths and Distances

With the Measure command on the Tools menu, you can determine the length, radius, or diameter of an edge on 
any component, or measure the distance between two faces or edges on two different components. You can also 
measure the distance from the active workplane or work axes to an edge or a face on any component.

You can use these measurements as you design new features on other components. As you perform a 
measurement, add it to the drop-down list on the Measure command dialog. You can access this measurement from
the drop-down lists on other command dialogs, for example, extrusion distance on the Extrude Profile command 
dialog.

Calculating Mass Properties

You can query the mass properties (volume and surface area) for the open part or any component that it contains. 
To query the mass properties for the open part, choose the Mass Properties command on the Assembly menu with 
no components selected. From the product structure browser, you can query the mass properties for any 
component contained in your assembly.

Understanding How Components Were Assembled

To understand how the components in an assembly fit together, examine their mating conditions. Mating conditions
constrain the position of a component relative to the other components in the assembly. They are shown in the 
Component Browser as small green clamp icons underneath the icon of the component that they constrain. You can
choose the Select Defining Geometry command to highlight the geometry used to define a mating condition.

See Also
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Understanding Update Problems

If Your Mating Conditions Don’t Update

Mating conditions may fail to update when you make changes to the components that make up your assembly. In 
the component browser, a component with mating conditions that do not solve is shown with a small red X across 
its icon. You can choose the Explain Problem command to receive a description of the problem.

A common cause of failure is two mating conditions that conflict with each other. To resolve this conflict, you need 
to determine which mating conditions to replace or delete. The Select Defining Geometry command highlights the 
geometry used to define each mating condition. With this command, you can examine the mating conditions and 
determine which ones to delete or replace.

If Your Assembly Can’t Find A Part File 

An assembly always looks for the parts that it references in the same directory where you last saved the assembly. 
If you move a part file to another directory, the assembly first looks for it in the directory where the assembly 
resides and then in the directories listed in your search path. When you move a part file to a new directory, add 
that directory to your search path. 

See Also
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About Derived Models

Component Features

The Use Component command on the Feature menu allows you to create a feature whose form and position is taken
from an assembly component. Such features are called component features. When you create a component 
feature, the component is hidden and equivalent solid material is added to the part in its place. You can then 
modify the part by adding further features, and this does not affect the original component part. The part is called 
a derived model, since its form is a derivation of the original component.

The component feature mechanism is associative, that is, changes to the original component part are propagated 
to the derived part. The derived part will show that a design update should be performed. You use the Update 
Design command to update the derived part when you are ready.

Concurrent Design

The original part and the derived part are separate parts that are stored in separate part files. This means that one 
person can be modifying the original part, while another person works on the derived part. See Sharing 
Information for more on concurrent engineering.

See Also
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Using Derived Models to Capture a Process

Design Continuation

The simplest application of component features is to create a derived model that adds further features to an 
existing part model. The existing part might be a conceptual design, and the derived model might be a detailed 
design. You can achieve this by creating a new part, adding the existing part as a component, then using the Use 
Component command to add that material to the part.

Design Alternatives

You can create two parts derived from the same original. The two parts could represent design alternatives. 
Perhaps details of the design depend on the manufacturing process to be used, and there are two processes under 
consideration. Modifications to the conceptual design are propagated to each of the derived models, maintaining 
and updating their detail features.

In-Process Models

You can add any part as a component. So you can use any model as the original for a derived model, including 
other derived models. This allows you to chain derivations together as a series. You can use this technique to 
represent in-process manufacturing models. 

Since you can place views of more than one part on a drawing, you can show in-process “before” and “after” 
models on the same drawing sheet to document a manufacturing setup.

See Also
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Using Derived Models for Advanced Design

Repeated Features

You do not have to create a component feature as your first feature in the derived model. If you have a repeated 
feature - perhaps a mounting turret for a circuit board inside a plastic part – you can model the feature as an 
isolated part. Then you can create a component feature for each instance of the feature within the main design. 

You can position the component in the correct place first using mating condition commands on the Assembly menu,
or using the Shift Point-to-Point command or the Transform command on the Edit menu. You can also create 
patterns of features by duplicating the component first, using the Duplicate command on the Edit menu. Then you 
can create a component feature for each duplicated component.

Changes made to the master feature can then be automatically propagated to the main design, updating each 
instance of the feature. You should use the Update Design command when you are ready to see the effect of such 
changes.

You can also create repeated features that are subtracted from the main design, such as a repeated pocket. The 
Use Component command offers you this option.

Mold Cavities

The cavity of a mold is the negative of the product it will produce. You model a mold cavity by bringing in the 
product design as a component and then using the component as a feature to be subtracted. This gives the mold 
has the desired negative form. Any changes to the product design are propagated to the mold design when you use
the Update Design command.

Welded Parts

You can use component features to unite components to form a single solid. If you have two plates to be welded, 
you can model each plate as a component part, and then create a component feature from each plate. When the 
second component feature is created, the solid material is combined with the solid material from the first feature, 
so that the two plates are fused as one. Then you might add a blend feature to represent a fillet weld.

See Also
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Introduction to Feature-Based Drafting
DesignWave has a feature-based drafting system. Unlike traditional 2D drafting, where dimensions are created 
between 2D lines that are part of views on the drawing, DesignWave dimensions and other annotation objects 
reference 3D model features directly. For example, the length of a rectangular block is dimensioned as the 
separation of two planar faces in the model.

Intelligent Drafting

Since feature-based drafting is based on 3D model features, DesignWave is able to validate features for suitability. 
When dimensioning in the drawing, suitable drafting features prehighlight as you move the cursor over them. If a 
feature is unsuitable, a message to that effect appears in the status bar. When you create a geometric tolerance, 
the datum reference frame and the orientation of the feature relative to the datums are validated for you, so that 
correct geometric tolerances are produced. See Feature-Based Tolerancing for more information.

Invalid Objects

When you make changes to the parts that are shown on your drawing, the annotation updates automatically. In 
some cases, you could make changes that invalidate the information shown on the drawing. The linear dimension 
showing the length of the block is invalidated if you change the part so that the two end faces are no longer 
parallel. A geometric tolerance of perpendicularity could be invalidated if you change the orientation of the feature 
or its datum. In such cases, the affected annotation in the drawing turns bright green to indicate that there is a 
problem. See About Invalid Annotations for more information. You can double-click on an invalid object to get an 
explanation as to why it is invalid.

See Also
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About Callouts and Callout Groups
When you create a linear dimension in the drawing, a dimension line and a dimension callout are created for you. 
The dimension line annotates the separation being dimensioned, and the dimension callout indicates the dimension 
value.

Callouts

The dimension callout is an object that displays text showing the value of a dimension. You can use the Properties 
command and select the Number page to see some of the properties of the dimension callout itself. You can change
these settings – such as the units or the number of decimal places - but they only affect the way the dimension is 
displayed. By using Copy and Paste commands, you can create two dimension callouts for the same dimension. 
Each dimension callout can display the dimension value in a different way. For example, one callout could show the 
dimension in inches, and another could show the same dimension in centimeters. 

Each type of information on the drawing has a type of callout used to display it. There are dimension callouts, 
datum callouts, tolerance callouts, and note callouts. You can use Copy and Paste to create two note callouts for 
the same note. One might be in a large sized font and the other might be in a small sized font and have a box 
around it. You can also use the Properties command to change the note itself. Then both callouts update to show 
the new text. See Using the Clipboard with Callouts for more information.

Callout Groups

Sometimes, as in our example above, the dimension line contains a callout group. A callout group is a set of 
callouts, formatted into rows. When you create a linear dimension, a callout group containing a single dimension 
callout is created. Afterwards you can insert more callouts into this group. For example, using the Insert Callout 
command allows you to insert a note callout before the selected callout. This produces a callout group containing 
two callouts: a dimension callout and a note callout. The Move Callout commands allow you to re-format the 
callouts within the callout group. See Re-Organizing Callouts in a Group for more information.

When you create a leader-directed note by dragging from a feature, you see a callout group containing a single 
note callout. You can insert more callouts into this callout group too.

Callout groups can be presented in three ways:

A callout group can be attached to a dimension line, like the linear dimension example above. A dimension
line can have zero or more callout groups attached to it. To create a new group attached to a dimension line, create
a note, starting your drag on a dimension line, and holding the SHIFT key down. To remove a callout group from a 
dimension line, select all of the callouts in the callout group, and use Cut and Paste to move those callouts to 
somewhere else.

A callout group can be attached directly to a feature. When creating notes, datum labels, or geometric 
tolerances, you can drag from a feature with the SHIFT key held down to produce a callout group attached to that 
feature.

A callout group can be free standing in the drawing. If you Paste some callouts when you do not have 
another callout selected to identify a target callout group, a new callout group is created in the center of the 
drawing ready for you to drag it to where you want it. Free standing notes can be created by dragging from a free-
space area of the drawing, with the SHIFT key held down.

In all three cases, a callout group can have one or more leaders drawn from it. In the example of a leader-directed 
note above, the callout group has a single leader drawn from it. To add a leader to an existing callout group, add a 
note to the drawing, but move the cursor over an existing callout before releasing the mouse button to finish the 
drag. The note callout is inserted before the existing callout. See Using Leaders for more information.

See Also
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Moving Annotation Objects

Repositioning Annotation

You can reposition annotation object, such as leaders, dimension lines, and callout groups, by dragging them. You 
have to select the object before you can drag it. Use the Annotations command on the Select menu to enter the 
mode for selecting annotation objects. The selected object is highlighted in red.

You can reposition dimension lines and callout groups by dragging them. A callout group attached to either a 
dimension line or feature moves along the object to which it is attached. It the callout group is attached using a 
shoulder, the shoulder stretches, if necessary, as you drag the callout group, unless you hold the SHIFT key down 
to maintain the length of the shoulder. You can add a shoulder to a callout group using either the Shoulder 
commands on the Dimension menu or the Properties command and selecting the Placement page.

Moving Callouts

Callouts within a callout group cannot be dragged. You can move the callout within the callout group using the 
Move Callout commands on the Dimension menu. You can also use Cut and Paste to move one or more callouts to 
another callout group. See Using the Clipboard with Callouts for details.

Dragging Leaders

Any callout group, even those attached to dimension lines or features, can have leaders connected. If you drag the 
callout group, any leaders connected to it move too. So if you have a leader-directed note, you drag the note to 
reposition it, rather than the leader. Dragging the leader has special behavior. See Using Leaders for details.

See Also
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Using Center Lines and Center Points

Centerline Features

A centerline represents a feature. Centerlines are the feature-based drafting equivalent of construction lines. For 
example, you can use the Mid-Plane command on the Center Line menu to construct a mid-plane. A centerline is 
displayed that represents a planar feature. You can use this centerline anywhere you want to use a planar feature. 
So you can dimension to the centerline, or even create a further mid-plane using it as one of the defining planes.

Centerlines are not only produced when you use commands on the Center Line menu. They are also produced when
dimensioning to axial features. See Dimensioning in a Specific Direction for more information. Overlapping 
centerlines are automatically merged. So if you dimension to an axial feature that has also been used to construct 
a row of holes centerline using the Common Plane command, the resulting centerline still phases correctly through 
the holes.

Center Point Features

DesignWave draws the short and long dashes of centerlines so as to phase correctly as they pass through the 
centers of features such as holes. Where the centerline passes through such a center, a center point is displayed. 
Center points also represent features. In the case of a center point at the center of a hole, the center point 
represents end-on straight line that is the axis of the hole. You can use the center point anywhere you would want 
to use such a feature. So you can dimension to the center point as an alternative to dimensioning to the hole itself.

See Also
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Creating Single, Datum and Chained Dimensions

Datum Dimensions

To create linear dimensions, choose the Linear command from the Dimension menu. This enters the mode for 
creating linear dimensions. You create dimensions by dragging in the drawing. First you must click on a feature to 
select it as the datum feature. Drafting features are prehighlighted as you move the cursor over them. The selected
datum feature is highlighted in red. Now you can drag from the second feature to where you want to position the 
dimension line, then release the mouse button. 

The datum feature remains selected allowing you to reuse it as you drag out further dimensions from other second 
features. This allows you to quickly create a set of linear dimensions all measured from the same datum feature. 

Spacing out Dimensions

As you position the dimension lines, they snap to grid points, so you can easily space out dimension lines equally 
by eye. Note that the grid size depends on how far in you are zoomed – see Selecting Grid Points for more 
information. So it is easier to space out dimension lines if you do not zoom in when you are part way through.

Single and Chained Dimensions

To select a new first feature, you must select another feature, without dragging. To create single or chained 
dimensions, select the first feature, then drag from the second feature each time.

Selecting Features

Remember that you can use centerlines and center points as features. See Using Center Lines and Center Points for
more information.

See Also

{button ,AL(`dimensioning')} Other topics on dimensioning



Dimensioning in a Specific Direction

Linear Dimension Centerlines

When you create a linear dimension between a planar feature and an axial feature, such as a hole, a perpendicular 
pair of centerlines is produced passing through the hole center. These centerlines take their orientation from the 
planar feature at the other end of the dimension. Each centerline represents a planar feature passing through the 
axis of the hole. One centerline is parallel to the planar feature at the other end of the dimension, and the other is 
perpendicular to it.

Construction Dimensions

Whenever you want to select a feature, you can select a centerline. The geometry represented by that centerline is
used. So you can select either of these the two hole centerlines as a planar feature in the creation of another linear
dimension. Having done that, you are free to delete the first dimension line. The second dimension captures the 
definition of the centerline selected, but does not depend on the first dimension line still being around.

This means that you can create throwaway linear dimensions as a means of constructing centerlines through axial 
features in a specific orientation. Having done that, you can use that orientation to orient subsequent linear 
dimensions. So you can create the dimension between two holes in a direction parallel to some other feature, by 
first creating a dimension from that other feature to one of the holes.

See Also
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Dimensioning to Corners

Using Existing Corners

When creating dimensions, suitable features are prehighlighted as you move the cursor over them. Usually linear 
dimensions are created between surface features, such as planar faces. For example, the linear dimensioning 
showing the length of a block is defined as the separation of the two planar faces at each end. If the part is 
tapered, edges are prehighlighted instead, since the planar faces there are not side-on and are therefore unsuitable
for a dimension in that view.

Sometimes you want to dimension to end-on straight edges at corners of a profile. Such edges are only one pixel in
size on the screen, so they are prehighlighted using small black squares. This ability is only available when creating
linear dimensions. To select end-on straight edges, you have to be quite close to them. 

If you select an end-on straight edge at a corner as the first feature of a linear dimension, you can continue to 
reuse this feature as you drag from further second features, but the small black square will not be visible all the 
time.

Constructing Corners

If you need to dimension to a corner that must first be re-constructed, such as the corner where there is a 
chamfer, you must use the Phantom Intersection command on the Center Line menu to produce the side faces so 
that they intersect. The feature that is created is the end-on straight line that represents the intersection of the 
two planes.

See Also

{button ,AL(`dimensioning')} Other topics on dimensioning



Choosing the Measurement
To keep dimension creation as simple as possible, set many of the options that you might want to specify for the 
dimension by first creating the dimension, and then using the Properties command to edit what you created.

Inside, Outside, or Between Centers

One common example is when creating a linear dimension involving axial features that have a radius. When you 
create a linear dimension between two holes, the distance between the holes is shown. But if you have a slotted 
hole, a rectangular cutout with semi-circular ends, and you dimension between the two end faces, you probably 
want the dimension to the outsides of the faces, not the axes. To do this, you first create the dimension between 
the axes, and then choose the Properties command, select the Measurement page, and change the dimension to use
the outsides. You can select either the dimension line or the dimension callout to do this.

See Also
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Creating Angular Dimensions
Angular dimensions are created in the same manner as linear dimensions. See Creating Single, Datum and Chained
Dimensions for details. You first click on a feature to select it, and then you drag from the second feature out to 
where you want to position the dimension line. You can reuse the first feature as you drag out from further second 
features in a datum-dimensioning scheme. To select a new first feature, click on another feature without dragging.

If you hold the SHIFT key down, the major angle is presented instead of the minor angle. You can also choose the 
Properties command and select the Measurement page to change between the major and minor angle after you 
have created the dimension.
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Dimensioning the Angle Between 3 Holes
Unlike linear dimensions, which can take many combinations of feature geometry, angular dimensions are always 
created between two planar features that are side-on in the drawing view. Since planar features have a natural axis
of intersection, this allows angular dimensions to be created without having to specify an axis.

Using Centerlines to Construct Planes

In situations where you do not have planar features, you can construct them using commands on the Center Line 
menu. A common case is the angle between two holes, measured about a third axis hole. You should use the 
Common Plane command twice to construct the two planes that pass through the axis of measurement. Then you 
can create the angular dimension between the two centerlines you have produced.

Using Linear Dimensions to Construct Planes

The topic Dimensioning in a Specific Direction describes another way of achieving the angle between three holes. 
You first create two throwaway linear dimensions, between the axis hole and each of the other two holes. This 
produces centerlines at the other two holes oriented in the direction of the axis hole. These centerlines represent 
planar features, so you can select these to create the angular dimension. Then you can delete the two linear 
dimensions.

The result you get with these two approaches is slightly different. Use the approach that gives you the result you 
want.

See Also

{button ,AL(`dimensioning')} Other topics on dimensioning



Creating the Angle from Vertical

You can use the same technique as described in Dimensioning in a Specific Direction to dimension the angle from 
the vertical, or from any other phantom direction. If you create a linear dimension from a vertical feature, such as 
the end of the part, to a corner where there is no vertical feature, an extension line is created from the corner to 
the dimension line.

The corner is actually an end-on straight edge in the model. Like centerlines, extension lines are features that you 
can use. In this case, the extension line represents a planar feature passing through the straight edge at the 
corner. You can use this planar feature to create an angular dimension. Then you can delete the linear dimension 
line, which was only used to construct the feature to use.
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Dimensioning the Angle of a Cone
When creating angular dimensions, you are required to use two planar features that are side-on in the drawing 
view. Dimensioning the angle of a conical face does not fit well into method of creation, since there is only one 
feature involved, and it is not planar.

Nevertheless, you can still dimension the angle of a conical face by another approach. You can use the Insert Callout
command to insert an angular dimension callout before the selected callout. The selected callout must be one that 
identifies a conical feature. To do this, you must create a leader-directed datum label or feature control symbol that
references the conical feature. Creating a leader-directed note for the feature is not satisfactory, since a note does 
not store a reference to the feature you selected. Having selected the callout, you can use the Insert Callout 
command to insert the angular dimension callout into the callout group. Then you can delete the first callout if you 
want.
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Controlling Styles and Measurements

Converting Between Radial and Diametric

When you use the Radial command on the Dimension menu to create a radial dimension, it is directed using a 
leader. When you use the Diametric command, a dimension line is produced instead. Sometimes you will want to 
show a diametric dimension using a leader, or a radial dimension using a dimension line.

To do this, you can use the Properties command afterwards and select the Measurement page. You can toggle the 
dimension between radial and diametric. This changes the callout to show twice or half the measurement. So, if 
you want a diametric dimension using a leader, you should create a radial dimension, then change it to diametric. 
And if you want a radial dimension using a dimension line, you should create a diametric dimension, then change it
to radial.

Radial Dimension Lines

For a dimension line, changing the measurement from diametric to radial also changes the style of the dimension 
line so that it only has one arrowhead, instead of two. The arrowhead that is kept is on the side where the cursor 
was when you positioned the dimension line. So, you can drag the dimension line to change the side.
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Suppressing Center Lines
Centerlines are produced when you use commands on the Center Line menu or when you create dimensions using 
axial features. You can control the style of centerlines choosing the Properties command and selecting the Center 
Lines page.

Displaying Hole Centers

When you use the Center Points command on the Center Line menu, two perpendicular centerlines are drawn 
crossing at the axis of the selected hole feature. At the axis, a center point is drawn.

This is most likely what you want for a hole, but if you just want to mark the center of a radius, you probably do 
not want centerlines drawn, just the center point. To do this, you double-click on one of the centerlines produced to
display the Properties dialog, and you clear the box labeled Draw centerlines to boundary on the Center Lines page. 
This removes the centerlines, leaving only the center point.

See Also

{button ,AL(`dimensioning')} Other topics on dimensioning



Feature-Based Tolerancing
DesignWave drafting is feature-based. See Introduction to Feature-Based Drafting for more information. When you 
add datum labels and feature control symbols to the drawing, geometric tolerance information is captured in terms 
of 3D features in your part model. DesignWave has built-in intelligence for geometric tolerances to help you apply 
valid tolerances to the drawing.

You are only invited to choose datum features if datums are valid for the selected tolerances type. For 
example, a flatness tolerance does not have a datum feature.

You are only invited to supply a material condition if the feature is a feature of size.
The datum reference frame you supply is validated. For example, you cannot provide two datum features 

that are parallel.
The orientation of the feature being controlled is validated against the datum feature according to the 

tolerance type chosen. For example, you can only add a parallelism tolerance if the feature really is parallel to the 
datum selected.

You might make changes to the part so as to invalidate geometric tolerances you have applied to the drawing. For 
example, you might change the part so that a feature with a parallelism tolerance is no longer parallel to its datum 
feature. When you change the part, the drawing is automatically updated and any geometric constraints are 
validated. If tolerances are invalidated, the tolerance callout turns bright green to indicate that there is a problem. 
You can double-click on the callout to get an explanation of the problem.
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Adding Datum Labels
When you declare datums for a feature control symbol, you identify datum features that have already been named.
So you should label datum features first.

Labeling Features

To create datum labels, choose the Datum Feature command on the Dimension menu, or press the button on the 
drafting toolbar. Then you can drag from a feature to create a datum label for it. If you hold the SHIFT key down, 
the label is attached directly to the feature, otherwise it is directed to the feature using a leader. To set the name 
of the datum, double-click on the datum callout and enter the name in the Properties dialog on the Datum page.

Mid-Plane or Axis as a Datum Feature

Where the axis or mid-plane of a feature is used as a datum, it is common to show the datum label attached to a 
dimension line for that feature. According to your drafting standard, you will either want to add the datum callout 
into the same callout group as the dimension callout (typical of ANSI), or you will want to attach a new callout 
group to the dimension line containing the datum callout (typical of ISO).

To add a new datum callout after a dimension callout, select the dimension callout and then use the Insert Callout 
command to insert a datum feature callout. Inserted callouts appear before the selected callout, so you might want
to move the datum callout within the callout group. See Re-Organizing Callouts in a Group for details.

To attach a new callout group to the dimension line to contain the new datum callout, choose the Datum Feature 
command on the Dimension menu, and then drag from the dimension line. If you hold the SHIFT key down, a new 
callout group is attached directly to the dimension line, otherwise it is directed to the dimension line using a leader.

Dimension Line Extras

If you apply the datum label as a new callout group (typical of ISO), either directed using a leader, or attached 
directly to the dimension line, you may also want to add a triangle terminator to the dimension line. 

If the callout group is directed using a leader, you can double-click on the leader to bring up the Properties dialog 
and go to the Leader page. Or, if the callout group is attached directly to the dimension line, you can double-click 
on the leader to bring up the Properties dialog and go to the Placement page. In either case, you can select a 
terminator where it says Dimension line extras. This terminator is added to the dimension line on the side closest 
to the leader terminator or attached callout group. If you drag the leader terminator or callout group to the other 
end of the dimension line, the terminator will jump to the other end too.
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Adding Feature Control Symbols

Application of Feature Control Symbols

You create feature control symbols, also known as geometric tolerance callouts, in the same manner as datum 
labels. You can create them attached to features, leader-directed to features, attached to dimension lines, or 
leader-directed to dimension lines, and you can insert them in existing callout groups - just the same as with 
datum labels. See Adding Datum Labels for details.

Entering the Tolerance Control

The feature control symbol produced does not display a geometric tolerance until you edit its properties. Use the 
Properties command and select the Tolerance page. You can set the tolerance type, the tolerance value, the 
material condition, and the datum features. You are only offered options that are appropriate for the tolerance type
you select. See Feature-Based Tolerancing for more information.
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Creating Textual Notes

Adding Notes

To create textual notes, choose the Note command on the Dimension menu, or press the button on the drafting 
toolbar. Then you can drag to create notes. Different forms of presentation are produced depending on where you 
start the drag:

If you drag from a feature, a note is created that is directed to the feature using a leader. If you hold the 
SHIFT key down, the note is attached directly to the feature, using an extension line or centerline as appropriate.

If you drag from a dimension line, a note is created that is directed to the dimension line using a leader. 
The leader has a null terminator. You might use this style when there is not enough space to show a dimension 
callout on the dimension line. In that case, you would use Cut and Copy to move the dimension callout to the 
leader-directed callout group, then delete the note callout. If you hold the SHIFT key held down while dragging, the
note is attached directly to the dimension line as in new callout group.

If you drag from empty space on the drawing, a leader-directed note pointing to that space is created. A 
blob terminator is used since this is the style typically used to point to faces. If you hold the SHIFT key held down 
while dragging, the note is created without a leader, as a free standing textual note. You could also delete the 
leader to produce the same result.

Prefixing a Note

To insert a note before an existing callout, you can choose the Insert Callout command. You might do this for a 
dimension applied to a pattern of features, in order to quantify the number of features in the pattern.
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Using Leaders

Creating Leaders

Many commands can produce leaders: adding notes, datum labels, feature control symbols, or radial dimensions. 
In these cases, a leader is created for a newly created callout group. You can also add a leader to an existing 
callout group. You might do this because the callout group does not have a leader, or because you want it to have 
more than one leader.

Whenever you are creating an annotation object and you are dragging to position the callout group and leader, if 
you release the mouse over an existing callout, the leader is added to that callout group, and the new callout is 
inserted before the existing callout. If you just want to add a leader, you might create a note in this way, and then 
delete the note callout.

Modifying Leaders

Leaders update whenever their callout group, or the object to which they point, changes. To move a leader, you 
move the callout group and the leader follows.

If you select a leader, you can modify it by dragging from different points on the leader:

If you drag from the shoulder of the leader, a new jog point is created. To remove all jog points, you can 
double-click on the leader to bring up the Properties dialog, select the Leader page, and check the Remove jog 
points option.

If you drag an existing jog point, the jog point is repositioned.
If you drag the terminator, the terminator is repositioned. Leaders pointing to features and dimension 

lines, are initially created pointing perpendicular to that object. You can drag the terminator to override this. To 
make the termination perpendicular again, you can double-click on the leader to bring up the Properties dialog, 
select the Leader page, and check the Perpendicular to target option.

The Properties dialog also allows you to change the terminator.
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Re-Organizing Callouts in a Group
Callouts are formatted in rows within a callout group. See About Callouts and Callout Groups for more information. 
You can move the selected callout around within its callout group using the Move Callout commands on the 
Dimension menu. The arrow keys and the ENTER key are provided as keyboard shortcuts to these commands.

You can also move callouts to a different callout group, or to become a new callout group. See Using the Clipboard 
with Callouts for more information.
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Using the Clipboard with Callouts
You can use the clipboard commands – Copy, Cut and Paste – with callouts. Using Cut and Paste allows you to 
move the selected callouts to another callout group. See Dimensioning Hole Features for an example of this. You 
can Cut several callouts at once, and they do not have to be in the same callout group. Using Copy and Paste 
allows you to duplicate callouts. See Creating Tabular Dimensions for an example of this.

Dual Units Dimensioning

You can use Copy and Paste to duplicate a callout within the same callout group. You might do this to produce a 
dual units dimension. Having created the dimension, you can select the dimension callout, then choose Copy 
immediately followed by Paste to duplicate the callout. Then you might press the DOWN arrow key to move the new
callout to the next line within the callout group to produce a presentation style typical of dual units dimensioning. 
Now you can choose the Properties command, go to the Number page, and change the units used to display the 
value.
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Dimensioning Hole Features
You can use Cut, Copy and Paste to move and duplicate callouts. See Using the Clipboard with Callouts for details. 
This allows you to remove dimension callouts from dimension lines and present them in some other manner.

You can use this approach to produce hole dimensions. See Adding Holes for more on hole features. Typically for 
holes, you might show all the dimensions for the hole in a single leader-directed callout group.

In the example shown, the hole was first dimensioned using two diametric dimensions and two linear dimensions. 
Then a note was added pointing to the hole feature. To point to the axis of the feature, rather than the surface, you
can double-click on the leader to bring up the Properties dialog, go to the Leader page, and change the termination 
to be To center or axis.

All the dimension callouts were selected, and then Cut and Paste were used to move them to the leader’s callout 
group. The four dimension lines were then deleted. Finally some further textual notes were inserted and the 
callouts were arranged in their intended rows. 

See Creating Textual Notes and Re-Organizing Callouts in a Group for details.
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Dimensioning Pitch Circles
You can use Cut, Copy and Paste to move and duplicate callouts. See Using the Clipboard with Callouts for details. 
This allows you to remove dimension callouts from dimension lines and present them in some other manner.

You can use this approach to dimension pitch circles. In this example, the Pitch Circle command on the Center Line 
menu was used to produce the centerlines for the pitch circle. 

The pitch circle was dimensioned using a radial dimension, so as to produce a leader rather than a dimension line, 
then the measurement was changed to diametric. See Controlling Styles and Measurements for details. One of 
each size of hole was dimensioned using a diametric dimension. Then these two dimension callouts were moved to 
the leader’s callout group using the Cut and Paste commands. The redundant dimension lines were then deleted.

Finally some further textual notes were inserted and the callouts were arranged in their intended rows.
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Creating Tabular Dimensions
You can use Cut, Copy and Paste to move and duplicate callouts. See Using the Clipboard with Callouts for details. 
This allows you to remove dimension callouts from dimension lines and present them in some other manner, such 
as in a table. The callouts still update automatically when you make changes to the part.

In the example here, the dimension values in the table are dimension callouts in free standing callout groups. The 
callout groups were individually positioned in rows and columns. 

The view was first dimensioned using regular linear and radial dimensions. Radial dimensions were used since this 
produces leader lines pointing to the holes, but each dimension callout was then changed to a diametric 
measurement. See Controlling Styles and Measurements    for details.

A prefix note was inserted before each of the three diametric dimensions. See Creating Textual Notes for details. 
Each note was duplicated in the first column of the table using the Copy and Paste commands. Each dimension 
callout was moved to the table using the Cut and Paste commands. The six linear dimension lines – without callout 
groups attached – were then deleted.

The labels on the axes were added as notes attached to the feature. Then these were duplicated in the table 
headings using the Copy and Paste commands.
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Creating Ordinate Dimensions
You can generate alternative styles of dimensioning by using the centerlines and dimension callouts from regular 
dimensions. The centerlines are valid features to which you can attach callouts. You can then use the Cut and Paste
tools to move the dimension callouts from the dimension lines into the new callouts that you have created. See 
Using the Clipboard with Callouts for details on how you can do this.

In the example here, the holes were first dimensioned from the side faces using regular linear dimensions. Callout 
notes were then attached to the centerlines generated by the linear dimensions. The SHIFT key was held while 
dragging each callout in order to attach it directly instead of it being leader directed. See Creating Textual Notes for
more details.

Each dimension callout was moved into its corresponding note callout using the Cut and Paste tools. The callouts on
the side faces were edited to contain '0's. The unused notes and remaining dimension lines - without callout groups
attached – were then deleted.

The orientation of one of the callouts was changed to be Along and Above the line using the Placement page of its 
Properties. The Pick Up Properties tool was then used to capture its placement and this was copied to the other 
callouts using Apply Properties to give them the same appearance. See Copying Styles to Other Objects for how to 
do this.
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Setting Up Drafting Standards

Setting up Styles

Many of the styles that affect annotation in the drawing are taken from settings you establish using the Options 
command. There are various pages in the Options dialog, and many of these affect the style of annotation:

The Dimension page allows you to set up the tolerance style and default tolerance for dimensions created 
in the future. You can also set up options to create basic dimensions or reference dimensions.

The Datum page allows you to set the style used for datum labels.
The Placement page allows you to say how you want the text to be drawn when attached to dimension 

lines or directly to features. You might say that you want the text to be horizontal and in-line with the dimension 
line.

The Number page allows you to set the units and decimal places for dimensions in the drawing.
The Leader page allows you to set the length of the horizontal shoulder that connects the leader to the 

text.

The settings you choose using the Options command only affect annotation created from that point onwards. So 
you should establish all these settings beforehand, so as to conform to your drafting standards.

Changing Styles

You can change settings for annotation already created using the Properties command. See Editing Annotation 
Properties for more information. You can also apply settings to many or all of your annotation objects. See Copying
Styles to Other Objects for how to do this.
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Editing Annotation Properties
When you create annotation objects, many of the styles come from the settings you have chose using the Options 
command. You should use the Options command to set up your drafting standard. See Setting Up Drafting 
Standards for more information.

You can change the style of an existing annotation object using the Properties command. You can select the object 
and then choose the Properties command, or you can simply double-click on the object to bring up the dialog 
window. To change the properties of more than one object, you can use the Pick Up Properties and Apply Properties 
commands. See Copying Styles to Other Objects for more information.
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Copying Styles to Other Objects
To use the Properties command to examine or modify settings, you must have a single object selected. See Editing 
Annotation Properties for more information.

If you want to change the properties of several objects, you should modify one object first so that it has the 
settings you want, and then use the Pick Up Properties and Apply Properties commands to apply these settings to 
the other objects. You can use the Select All command to apply properties to all annotation objects in your drawing.

The Pick Up Properties command offers you categories that correspond to settings or groups of settings that you 
see in the pages of the Properties dialog. You should select those categories you wish to pick up. Then the Apply 
Properties command applies just those categories of settings that you chose to the currently selected objects.
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About Invalid Annotations

Implied Constraints

When you create dimensions and geometric tolerances, as well as calling out information on the drawing, you are 
also applying geometric constraints to the model. For example, if you add a linear dimension between two planar 
faces, you are implying that these two faces are parallel. And if you add a perpendicularity tolerance to a feature, 
you are implying that it is indeed perpendicular to its datum feature.

When you construct centerlines, you are also implying geometric constraints. For example, if you use the Common 
Axis command to produce a centerline through two co-axial features, you are implying that they are indeed coaxial.

Validation

You cannot create dimensions, geometric tolerances, or centerlines that are invalid. If you try to create the linear 
dimension between two planar features that are not parallel, the cursor changes from the creation pencil to the 
selection arrow to indicate that you cannot create the dimension. 

However, you can produce invalid annotation objects by changing your part. If you change the part so that the two 
planar faces of a linear dimension are no longer parallel, or the two axial features defining the centerline are no 
longer co-axial, this means that the geometric constraints are not satisfied, and the objects become invalid. 

Invalid Objects

An invalid object is displayed in bright green to indicate that it has a problem. You can double-click on the object to
get an explanation for the problem. In many cases, pressing the F1 key will give you some additional help along 
with some suggested courses of action. Note that you cannot see the bright green color if the object is currently 
selected, since it will be shown in red.

Dormant Features

When you make changes to your part, these changes are reflected immediately in views of that part shown in the 
drawing. If you suppress a feature and then update your design, the faces and edges for that feature no longer 
appear in the model. So they no longer appear in views of that part in the drawing. Such faces and edges are 
called dormant, because they are not actually deleted, just taken out of service until further notice. If you 
unsuppress the feature and update the design, the faces and edges come back to life.

Annotation objects can become invalid because their inherent geometric constraints are not satisfied, or because 
the features used to define them are currently dormant. For example, if you dimension the position of a hole, and 
then suppress the hole and update the design, the dimensions to that hole will turn bright green to show that they 
are invalid. If you double-click on the dimension line or dimension callout, the explanation will tell you that a 
feature is currently dormant. If you then unsuppress the hole and update the design, the dimensions will spring 
back to life, updating their values if need be.
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Introduction to Drawings
Drawings convey design information in a 2D representation for parts and assemblies previously modeled. You 
create a drawing by selecting one of the common paper sizes, defining your own size or by referencing a template 
drawing from which the new drawing derives its size.

Sketches

You can add your own sketch to drawings, using the same tools you use to create sketches in the modeling 
environment. Sketches are used as input to some of the view creation tools.

Drawing Views

A drawing can contain views of any number of parts. You add primary views to a drawing by selecting from a list of 
the open part windows. You can individually scale these views or define an overall scale factor for the whole 
drawing. You can then derive projection views and section views from the primary views. Crosshatching for section 
views is generated automatically.

Annotation

Intelligent annotation tools allow you to add dimensions, callouts, and tolerance information in a context-sensitive 
manner. You can even add dimensions between different views of a part. Part views and annotations that reference 
model geometry are associative. If you modify a part, its drawing views will be updated to reflect the changes. 

When you open a drawing, any referenced part files are opened, too. Therefore, when moving a drawing from one 
system to another, be certain to include all the part files.

Printing Drawings

You make hardcopies of drawings by printing the document. You can send scaled-down proof plots to the office 
printer and full-size plots to the intended plotter.
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Using Sketches
A drawing contains a single workplane in which you can add as many sketches as you like. The tools for creating 
sketches and lines are the same as the sketch and line tools in a part window.

You can use sketches in a drawing to contain user-defined lines, such as a sheet border, header block, or a revision 
grid. You also use sketches to define section cuts for section views and clipping boundaries for partial views. Since 
a sketch can be used for a variety of purposes, give it a meaningful name, such as "Section A-A". This will make it 
easier to identify the sketch later.

The sketch commands are available on the Drawing menu. See Introduction to Sketching for more details.
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About Sheet Properties
When you create a drawing, you can enter some of its properties, such as size and scale. You can change these 
later by choosing the Sheet Setup command on the Drawing menu. For example, if you find that you cannot fit all 
the views you want on a drawing, you can either select a larger drawing or you can adjust the scale factor applied 
to all views.

Sheet Size

You choose the sheet size from a list of ISO and ANSI standard sizes or you can enter your own custom size. 
Alternatively, you can select another drawing to be used as a template, which also defines the sheet size. The sheet
extents are shown in a drawing window as a dashed line. This will not appear in plots.

Scale

You can specify a scale factor for the drawing, which defines the default scale for all views on the drawing in terms 
of a ratio of paper to model. You can also set the scale for each view individually, but it is usually easier to set the 
default for the drawing. This way, you can usually avoid having to specify a scale each time you create a view. The 
view scale simply determines how large a view will appear on a drawing of a given size. It does not scale the 
geometry within a view.

Units

When you create models, you work in the units specified for model distances. Internally, all distances are 
standardized to SI units. This means that you don't need to know what units a model was created with when you 
create a view of it on a drawing. When you create lines in a drawing or specify the sheet size, you work in the units
specified for paper distances. You can set both these units on the Units page.

Numeric values that you see on the drawing itself, such as dimension values, take their measurements directly 
from the model and specify their own units for display purposes. You can set the default units for numeric values 
using the Number page.
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Using Formats
When you create a new drawing, or later using the Sheet Setup dialog, you can specify the sheet size or you can 
select an existing format. A format is, simply, another drawing, whose lines and text are superimposed on the 
drawing that references it. The format also defines the sheet size. When you change a format, any drawings that 
reference it will be updated when they are opened.

Normally, engineering drawings contain a border and sheet header block with drawing information, such as 
standards conformation, and a company logo. You can place all of these common lines and text objects on a set of 
drawings to be used as formats. Whenever you create a new drawing, you can select an existing format and see all
the shared objects. Later, if you wish to alter the style of border or change the header block, you need only change 
the format drawing.

If you move a drawing to another system and it references a format drawing, be certain to include the format, too.
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Creating Formats
You create a format by creating a new drawing and adding the lines and text you want to see on all drawings using 
that format. The content of the format drawing is not editable on a drawing that references it, so you avoid adding 
text that you will want to change for each drawing. You should create a different format for each sheet size you 
use.

When you define the border on your format drawing, depending on the printer or plotter device you are using, you 
will probably need to offset the border lines in by a small distance to allow for a margin. If you place the border 
lines directly on the sheet boundary, you may lose the upper or right border when printing. This is because the 
printable area is often slightly less than the physical paper size, due to the printer imposing its own margins.
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Adding the Principle View
Typically, a drawing contains at least one principal view of a part; that is one of the standard elevations such as 
plan, front, left side and right side. Before you add a principal view of a part to a drawing, you first select the 
desired view direction in the open part window. The standard elevations are available on the View menu. You then 
choose the Add Modeling View command on the Drawing menu and select from a list of all the open parts in the 
current session.

You can add other views of the same part by repeating this procedure after reorienting the view in the part 
window. You can add views of any number of different parts to a drawing. Normally, the set of views for a particular
part follows a standard convention, such as first or third angle projection. If you wish to create projected views, it 
is usually easier and more beneficial to use the Add Projected View command.

After you add a view, the Select Views command is active. In this mode, views are displayed with a surrounding 
dashed box. You select a view by selecting its bounding box and you reposition the view by dragging the box to a 
new location.

You change the properties of a view by double-clicking its boundary. You can control the display of hidden lines, 
scale the view, or specify a clipping boundary to create a partial view.

See Also

{button ,AL(`drawings')} Other topics on drawings



Creating Projected Views
Projected views are created from existing drawing views. You create a projected view by first selecting a side-on 
face onto which you want a projection to be made and then choosing the Add Projected View command on the 
Drawing menu.

Once created, a projected view remains associated to its defining view, including knowledge of the face from which 
the projection was made. You can reposition a projected view wherever you want by dragging its border. By holding
the SHIFT key down while dragging, you can maintain the correct alignment for the projected view. Position the 
view accordingly to achieve first or third angle projection.

You can create angled auxiliary views by projecting from any side-on planar face. The orientation of the auxiliary 
view will always be maintained at the correct angle.
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Adding Secondary Views
You can add isometric or trimetric views by activating the part window and choosing the desired view direction on 
the View menu. You can then add this view to the drawing, as you would a principal view.
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Removing Hidden Lines
By default, hidden lines are shown as dashed lines. You can turn off the display of hidden lines for an individual 
view by selecting the view and adjusting its properties. You can redisplay the hidden lines later, if you wish.
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Aligning Views
Normally, a projected view is shown aligned with its principal view along the axis of projection. If you reposition a 
principal view and you have projected views associated with it, the projected views are aligned automatically. 

You can further adjust the position of a projected view by selecting it and then dragging its border while holding 
the SHIFT key down to maintain the alignment with its projection. If you reposition a projected view, you can 
quickly realign any other views that are meaningfully related to it by choosing the Align Other Views command on 
the Drawing menu. 
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Updating Views
All drawing views are associative. This means that they will be updated to reflect changes made to the underlying 
part. When    you modify a part, all drawing views of it will initially be shown as a black wireframe rendering instead
of the normal dark blue hidden line image. This indicates that the views on the drawing need updating. At this 
point, you can choose the Update Views command to regenerate the hidden line images in the drawing views.

When you update a view, you also regenerate any projected views associated with it. Any annotation that 
references the views is updated automatically.

In some situations, a view can become invalid if the objects used to define it are missing or invalid themselves. An 
invalid view will be shown with a green dashed bounding box. You can determine the reason for an invalid view by 
double-clicking its boundary in view selection mode and looking at its properties.
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About Section Views
A section view is defined by a principal or projected view - the exterior view - and a section cut through that view. 
You define the section cut using a sketch containing connected straight lines. You use the Add Section View 
command on the Drawing menu to create a section view and then specify the sketch to be used for the cut in the 
dialog window that is presented. Each section definition must live in its own sketch. There are rules that determine 
how the lines within the sketch generate the resulting section view.

There are two distinct types of section view in DesignWave; sectional views and cross-sections. Sectional views 
show the visible lines behind the section line and cross-sections do not show these lines.

Crosshatching is automatically generated where the solid is cut. Furthermore, if you section an assembly view, the 
crosshatch angle is alternated for each part in the assembly.

Section views are fully associative. If you move the exterior view from which the section is derived, the section 
view is aligned automatically; if you change the part or modify the section cut lines, you can regenerate the section
views with the Update Views command. Just like projected views, section views know how they have been created 
and in which direction they should be aligned. You reposition a section view by dragging its border. If you hold the 
SHIFT key down while dragging, the alignment is constrained along an axis perpendicular to the principal section 
line.

Section Lines

You define the section cutting planes using straight lines connected in a chain. Each solid line defines a section cut. 
There is always one principal section line that extends outside the view. The projection of the resulting section view
is perpendicular to this line. You can connect another section line at an angle to obtain an aligned section. You can 
create steps in the section lines to obtain offset sections, but you must join any adjacent stepped segments with a 
construction line.

To indicate to which side of the principal section line you want the section view to be projected, you append a 
construction line to the principal section line pointing away from the eye. This construction line also indicates the 
principal section line.

When you create the sketch for the section definition, remember to give it a meaningful name, such as "Section A-
A", so that you can identify it from other sketches in the drawing.

If you want the section line to pass through attraction points of model edges, such as the center of a hole or the 
midpoint of an edge, turn the Edges check box on temporarily. You will probably need to turn it off again to connect
the section lines.
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Creating Cross-sections
Sometimes, section views are used to describe a profile or 'slice' of a solid, without showing the visible lines behind
the cutting plane. You can create a cross-section in the same way as you would a sectional view just by choosing 
the cross section option when the view is created. Alternatively, you can change a sectional view to a cross-section,
or vice versa, by double-clicking the view boundary and changing its properties. After you make a change, choose 
the Update Views command to regenerate the section view.

This example shows a cross-section through a swept solid. The view has been moved to a position coaxial with the 
section cut line.
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Creating Half Sections
Half sections refer to section views that are only partially sectioned. You create a half section view by stepping the 
section definition outside the view at the point at which you want the sectioning to finish, and continuing with 
another solid section line. You must connect the solid lines with a construction line.

This example shows a half section view through a shaft. One half of the shaft is sectioned and the other half shows 
the exterior. The wavy break line has been added as a separate sketch.
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Creating Offset Sections
A section view is defined by a chain of section cut lines. You can create offset section views by adding offset 
segments to the section definition. You must join the adjacent offset lines by a construction line to maintain a 
contiguous series of lines defining the section cut. The construction segments do not contribute to visible sectioning
in the resulting view. See Creating Aligned Sections for an example that includes an offset section.
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Creating Aligned Sections
You can create an aligned section view by adding a segment to the section definition at an angle. The same rules 
apply for the section definition line chain: it must be contiguous with offset sections joined by construction lines. 
The direction of projection is defined by the principal section cut, which is identified by an additional construction 
line. The tail of the construction line points away from the eye.

This example shows how a section cut line can define an aligned and an offset section view.
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Controlling Cross Hatching
Crosshatching is selectable as annotation. You can double click on an individual crosshatch object and change its 
angle from the horizontal, the line spacing or the phasing. A separate crosshatch object is generated for each 
component of an assembly. When an assembly view is sectioned, the crosshatch angle is automatically alternated 
from positive to negative for adjacent parts - a common practice when sectioning assemblies to distinguish the 
components. If you want to provide further distinction, you can change the crosshatch properties of any individual 
part.
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Clipping Views
You can clip any existing drawing view to create a partial view. The clipping boundary is defined by a sketch 
containing straight, contiguous lines forming a closed boundary. Remember to create a new sketch for the clipping 
boundary and apply a name that will help you find it later. To clip a view, double click its boundary to view its 
properties and check the clip option, giving the name of the sketch used to form the boundary.

You can change the boundary definition at any time afterwards. As long as the sketch defines a valid closed 
boundary, you will see the view update automatically as you edit the lines in the boundary. Later, if you want, you 
can remove the clipping option.

See Creating a Shortened View for an example of how clipping can be used.
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Creating a Detail Enlargement
You create a detail enlargement by choosing the Add Modeling View on the Drawing menu to add a view. You then 
enlarge the view by double-clicking its boundary and setting the scale factor in its Properties. Now you can define a
clipping profile in a new sketch and specify this in the enlarged view's properties page. See Clipping Views for 
details on how to clip a view.

See Also

{button ,AL(`drawings')} Other topics on drawings



Creating a Shortened View
You can create a shortened view by adding the view twice to the drawing. Scale and position the views so that the 
two ends show in their desired positions. You can define clipping boundaries for each view to obscure the remaining
parts. If you do not wish the clipping boundaries to show in the drawing, you can use the Sketches dialog to turn 
off the visibility of the appropriate sketches. See Clipping Views for details on how to clip a view.

This example shows a shortened view of a long shaft. In fact, it is represented using two enlarged, clipped views. 
The visibility of the clipping sketches has been turned off and the break lines have been added as a separate 
sketch. The feature based dimensioning used in DesignWave ensures that the separation values you see are always
correct for the model space, even though the actual features being referenced may be in different views.
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Creating Multi-Sheet Drawings
DesignWave does not impose any requirements or limitations on what views you choose to place on a drawing, or 
what constitutes a set of sheets defining a drawing. A drawing and a sheet are the same thing to DesignWave and 
each is stored as a file. You can define your own multi-sheet structure by storing the sheets making up a drawing 
set in their own folder.

For example, you can create a single drawing containing all the views of a simple assembly, including the individual
part views and section views. Alternatively, you can place some views on one sheet and, say, conceptual views on 
another sheet.
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Introduction to Feature Modeling
You can build parts by creating features. Each feature can consist of a number of Boolean operations. The feature 
modeling process starts with the construction of a basic shape, a profile. You can construct a base feature by 
extruding, revolving, or sweeping the profile. After you construct the base feature, you can add or remove material
from the base solid using a number of profile-based feature operations. You can use profile-based features like 
Extrude Profile, Project Profile, Revolve Profile or Sweep Profile.    You can use Extrude and Project Profile to create 
bosses, pads, pockets, and holes. You can use Sweep Profile to create pipes, grooves, and lips.    You can use 
Revolve Profile for the creation of curved pockets or bosses. You can also create a thin walled solid using Hollow 
Solids or you can use Blend Edges to create a blend, fillet or a chamfer.

Naming Features

Features have names.    The name is used whenever the feature is shown in the browser view.    Although 
DesignWave supplies a default name, such as “extrusion 2”, when you create a new feature, it is usually worth your
effort to give a more meaningful name that captures the intended use of the feature in the part. You can give a 
name for the feature at the time you create it or at any time afterwards by editing the properties of the feature.

Editing Features

You can edit Features by selecting them from the browser view and changing their Properties from property sheets.
You can modify Profile-based features by changing the sketch. You can also Condemn or Suppress or Reorder 
features using the feature browser. After editing, condemning, suppressing or reordering the features, the part can 
be updated by selecting Update Design from the Feature menu in part window or by pressing the Update Design 
button on the toolbar.
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Updating Your Model
You can edit features by changing feature properties or by changing the sketch it depends on. You can also 
suppress or condemn a feature in the feature browser.    Feature browser also allows you to reorder the features 
and to move the Finish flag. When you modify features, Update Design from the Feature menu (or Update Design 
button on the toolbar) becomes active. At this point, you can either regenerate the model or make more changes.

You may find that some features fail to regenerate while updating. Failure can occur for valid reasons, such a radius
that is too large, or the deletion from the model of faces and edges necessary to the feature. You can change the 
feature properties to repair the problem. You can also condemn or suppress the feature and update the rest of the 
features.

Stopping the Update Process

The Update dialog box displays during part update and indicates the progress of the update process.    You can 
press the Stop button in the update dialog to pause the update process. Subsequently you can press the Continue 
button to proceed with the update process or press the Stop button again to confirm that you want to stop the 
update process.

In some situations, you may need to indicate whether or not you want to continue the update process, even 
though you did not press the Stop button. For example, suppose you draw a rectangle and extrude it. Then, you 
select one of the side faces to create a workplane, sketch a circle on it, and extrude it to create a boss. You can 
blend some of the edges after that. However, if you change the lines in the rectangular sketch for the first 
extrusion to arcs, the workplane for the boss cannot regenerate successfully, since the face geometry it references 
is no longer planar. At this point, you can stop the update process and mend the problem, or continue to update 
the rest of the features.
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Using a Sketch More than Once
You can use the same sketch in multiple features. You may wish to use the same sketch in several situations, such 
as projecting the same sketch above and below workplane to create a throughole when the sketch is inside the 
volume of the solid.

Use of a sketch in multiple features can also be the result of an error.

You might select the wrong sketch from the list when using the Sketches command.
You might forget to create a new sketch before trying to create a feature.
You might draw lines on the active workplane without creating a new sketch, which results in the lines 

being added to the active sketch.

If you select a sketch that has already been used, you receive a warning message since this is often done 
accidentally. Just confirm that you wish to proceed.
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About Profiles
In feature operations, profiles are sketches drawn on workplanes. All lines that you create live in sketches, which 
belong to workplanes. 

You must have closed loops of nonintersecting lines for a valid profile. You may have inner loops that define “holes”
in the profile, but no further loops inside those. Inner loops provide a quick way of producing thin walled shapes in 
the profile-based features, but multiple levels of nesting are not allowed. You should not draw inner loops that 
touch the outer loop or are coincident with any portion of the outer loop. 

See Also

{button ,AL(`featureModeling')} Other topics on feature modeling



Modifying Profiles
You can modify profiles by adding new lines to the sketch or by deleting or modifying existing lines in the sketch. 
The resultant sketch should form a valid profile for the feature operation. You can use the Activate Sketch on the 
popup menu whenever you can see the sketch in the browser view.    When the sketch is activated Select Lines 
command in the toolbar becomes active and you are ready to modify the sketch. 

You can also convert some of the lines in the sketch to construction lines using Toggle Construction on the Lines 
menu. Construction lines do not participate in the profile for the creation of features.

You can change the workplane to which a sketch belongs from the Properties dialog of the sketch. You can use this 
to move features from one face to the other.
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Creating the Basic Shape
You can start constructing a part by creating a basic shape with a base feature. You can create the base feature by 
extruding a sketch, revolving a sketch, or sweeping a sketch along a path. 

Generally you can sketch the outer contour of the part you are going to model and use that as the profile for the 
base solid. You can then add detailed features to the part by adding and removing material from the basic shape 
using other feature operations.
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Adding Bosses, Pads, and Pockets
You can add bosses, pads, and pockets using the Extrude Profile command if you know the height for the pads and 
bosses and depth for the pockets. The contour of the pads and pockets are reflected in the sketches used. 

You can also create the bosses by Project Profile, projecting a sketch onto a solid and adding material.    Similarly, 
you can create pockets by drawing a sketch inside the solid and perform projection with material removal.

With pads or bosses, you are often more interested in the position of the top face than the height of the feature. 
Sometimes the height is not even well defined, since the feature is not sited on a planar face. You can create a 
workplane where you want the top face to be, sketch a profile, and then project the profile down onto the part.
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Projecting Profiles onto Your Model
You can use the Project Profile command to add ribs in a thin-walled part or to create througholes in a part. 

Often when extruding a profile toward a part to add a feature, you find that, in order to extrude far enough at one 
point, the material would be too long somewhere else and poke through to the inside or out of the back of your 
part. In situations like this, you can project the profile to the part.

You can add ribs to a thin-walled part by sketching long, thin rectangles across the face of the part you want to 
open. The rectangles can hang outside the part. Projection takes care of the trimming for you.

You can sketch a profile on the surface of your part and then project it down the part, removing material. You can 
create a set of holes at one time.
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Adding Revolved Features
You can add revolved features using the Revolve Profile command from Feature menu. You can use Revolve Profile 
to create spherical or toroidal pockets and protrusions in a part. You can also use Revolve Profile to create the base 
feature.

You should not sketch an axis of revolution that intersects the profile. You can use the sketch for axis of revolution 
as well as the profile in multiple features. The sketch for the profile and the sketch for the axis should be on the 
same workplane.
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Adding Holes
You can create holes in a solid in a number of ways:

If you know the extent of the solid, you can extrude the sketch of the hole by a distance greater than the 
extent of the solid and subtract material. You can use the Symmetric about workplane option for a throughole if the 
sketch is inside the volume of the solid.

If you do not know the extent of the solid, you can project the profile to create a throughole. You might 
need to project above and below the workplane using the same sketch to produce a throughole, if the sketch is 
inside the volume of the solid.
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Creating Pipes, Grooves, and Lips
You can create pipes, grooves, and lips on a solid by using the Sweep Profile command from the Feature menu. You 
can sweep a profile that is partly inside and partly outside the volume of the solid to create a lip or a groove. In 
these cases, the path along which the profile is swept, is often the contour of the solid or projection of the contour 
on a plane perpendicular to the plane of the profile.

You should create a sweep path that intersects the plane of the profile perpendicularly. Make certain the path does 
not have tight corners, otherwise DesignWave detects self-intersection. If there are multiple curves in the path, you
should make the curves tangent continuous to successfully produce the elbows.
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Adding Blends, Fillets, and Chamfers
You can add blends, fillets, or chamfers using the Blend Edges command from the Feature menu. You should blend 
edges of a part that have sharp corners that are difficult to manufacture or may lead to stress concentration when 
the part is under load. You might want to blend edges for aesthetic purposes, too.

The edges selected for a blend feature may not exist anymore while updating the part because you might have 
suppressed some features the blend depended on. 

The faces generated by a blend feature may change considerably if you have the Auto propagate option turned ON 
and reorder blend features.

It is recommended that blending be the last set of operations performed on a part. 
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Creating Thin-Walled Parts
You can construct thin-walled parts using the Hollow Solids command from Feature menu by selecting the faces to 
remove. You should create the thin wall after creating the basic shape along with the shapes for which you want 
the wall to be built. Generally, it is recommended that you perform blending after creating the thin-walled part.

You should select all the tangent faces of the part for removal. If you intend to open up only some of the tangent 
faces, the operation may not succeed. You can select all the tangent faces by selecting a face and then selecting 
the Add Tangent Faces command on the Select menu of the part window.

Make sure the offset distance for the hollow feature does not exceed the extent of the solid and is a reasonable 
distance. Otherwise, the feature may fail.
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Sketching on Faces
You can sketch on a planar face by selecting the face and selecting the Plane of Object command on the Workplane 
menu. This command generates a workplane coincident with the face and a new sketch. Then you can start 
drawing lines that are added to the sketch.    The workplane you created may fail to regenerate if the planar face it 
referenced before is not planar anymore during the update process.

If you do not create a workplane after selecting the face and you already have an active workplane coplanar with 
the face, you may start sketching thinking that you are creating a new sketch, but the newly drawn lines are added
to the active sketch.    Later when you try to create a feature, you receive a warning that sketch is being used by 
multiple features.

The workplane that you create on a face has the same normal as that of the face. You should accordingly perform 
the operation above or below the workplane. 

Note: The normal of a face always points outside the volume of the solid.
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Using Constructed Workplanes
Sometimes you need to create bosses extruded or projected at an angle to an existing face or edge or a 
workplane. In such situations, you can construct a workplane that is either at an angle to a face or an existing 
workplane, or the mid-plane between two selected faces, or passing through selected edges.

If the face you want to draw the sketch on is not planar, construct a workplane by offsetting another workplane.

You can find the direction of the normal to the constructed workplane by looking at the arrowheads of the work 
axes. If the arrowheads are filled, you are looking from above the workplane; if they are not filled, you are looking 
at it from below the workplane. Use of this fact when making a decision to extrude or project a profile above or 
below a workplane.
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Using the Workplane Browser
When you construct a workplane in terms of faces or edges of the model, the workplane is automatically 
repositioned, if necessary, when you use the Update Design command to update the design.    For example, if you 
have a workplane sited on the top face of an extruded profile, and you can use the Properties command to change 
the distance of the extrusion. When you do this, the workplane is updated when the design is updated so that it is 
still on that face, even though the face has moved.    

You can use the workplane browser to find the workplane sequence that is guided by the order in which the 
features exist in the feature tree at that instance. You may name the workplanes according to their position in the 
browser.

The workplane browser is also useful for browsing sketches that are not part of any features that cannot be viewed
from the feature browser.

The workplane that contains the active sketch is shown with its name in bold text.    If you expand that node in the 
browser, a list of sketches that belong to that workplane is displayed.    The active sketch is shown in bold.    

You can also change the properties of the sketches and workplanes from the workplane browser. The workplane 
browser also displays workplanes with a mark if the workplane geometry cannot be determined. 
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Deleting Unused Workplanes
You can delete unused workplanes after you have finished constructing all the sketches for the part to unclutter the
display and reduce the part size. Choose Select WorkPlanes from the toolbar and choose Select All from the Edit 
menu in the part window. All the workplanes in the document are highlighted. You can then press the Delete key 
on the keyboard or choose Delete from the Edit menu. At this point you receive the warning message: Some of the 
selected objects are not allowed to be deleted. This means that the workplanes that contain sketches cannot be 
deleted without deleting their dependents.
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Browsing Your Features
You can find the makeup of a part in terms of features using the Feature browser. The browser provides the 
sequence of the feature operations at any instance of time. The browser also provides information about failed 
features, whether a feature is suppressed or condemned.
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Examining Feature Properties
You can examine feature properties from the property sheet of that feature. The property sheet has two pages in it 
– one specific to a feature and the other is a generic feature page containing the name of the feature and 
Suppressed check box. If you get an error in creating the feature or during update and the error points to a specific
feature parameter, you can examine this parameter from the feature property sheet.

You can also double-click on the edges or faces created by a particular feature to see the property sheet. 
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Making Changes to Your Features
You can make changes to your features in several different ways – you can modify the sketch for the feature after 
activating the sketch by adding, deleting lines or modifying the existing lines. You can also change the parameters 
of the feature from the property sheet of that feature. Property sheets and sketches for a feature can be selected 
from the feature browser.

You can also double-click on the edges or faces created by a particular feature to see the property sheet. 
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About the Feature Browser
You can use the feature browser to view the sequence of features in a part. The browser also has a Finish flag and 
an Update flag. You can move the Finish flag to partially regenerate the feature tree. You cannot move the update 
flag – it moves depending upon the action you take. You can select a feature in the browser and select Suppress, 
Condemn from the popup menu. You can also select Properties to change feature properties such as name and 
parameters. If it is a failed feature you can select Explain Problem from the popup menu which displays a dialog 
box with the specific error message.

You can also double-click on each feature node to expand on the dependency list. For instance, extrusion 2 might 
expand to sketch 3, which, in turn, expands to workplane 4 , which depends on extrusion 1. Anywhere you see 
sketch in the browser you can select Activate Sketch, New Sketch, Sketches and Properties from the popup menu. 
You can use these commands to create a new sketch or modify an existing sketch. You can also get to the 
Properties of the workplane where you can change the name of the workplane or the offset distance.

You can find the edges or faces created by a particular feature by clicking on that edge or face and selecting 
Synchronize Browser from the Select menu in part window. The corresponding feature is highlighted in the browser.
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Moving the Finish Flag

You can move the Finish flag  in the feature browser to update a portion of the feature list. You receive a 
message asking whether you want to update the design. You can update the model immediately or move the flag 
further before updating the model.

When you drag the Finish flag to a highlighted feature, you place it before that feature. Moving the Finish flag is an
alternate way of regenerating the model without editing any feature properties.
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Suppressing Features
You can suppress a feature by selecting the feature in the browser view and clicking on Suppress from the popup 

menu. The Update flag  of the browser jumps before the feature and Suppress is checked on the popup menu. At
this time, Update Design is active also. The feature icons become 

 from the original icon 

You can also suppress a feature from the Properties sheet of a feature. Check the Suppressed check box in the 
Feature page. When you uncheck the box, you unsuppress the feature.

You may suppress features when they fail to update. You may also want to suppress all features of a particular type
like all the blends and regenerate the model for rough analysis purposes. Suppressing a feature may lead to 
failures while updating other features, since some of the faces and edges in the model can become dormant.
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Condemning Features
You can condemn a feature by selecting the feature in the browser and clicking on Condemn from the popup menu.
When you condemn a feature all its dependent features are also condemned. The number of dependent features 

displays in a message box. The condemned features appear in the browser with a  mark against them. The 
Update flag 

 jumps above the feature you condemn and Update Design becomes active.

When you update a part, if some feature fails, the update stops at that feature after reporting the problem. You 
have the option at that point to either mend the problem, suppress the feature, or condemn the feature. In some 
situations you might need to create some features solely for the purpose of constructing other features. You can 
condemn these features later on in the design process.

You can select all the features that you want to condemn from the browser and update the part in one shot. You 
can also use Uncondemn All from Feature menu to uncondemn the features. 

See Also
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Reordering Features
You can reorder a feature by selecting the feature in the Feature browser and dragging it in the browser view until 
another feature highlights in the browser. The dragged feature gets added to the browser before the highlighted 
feature. The part may change substantially when the features are reordered. 

As an example you can start with a rectangular block as the base feature, hollow the block selecting the top face to
be removed and put a throughole in the block using a sketch on the top face and extruding below workplane. A 
thin-walled solid is created with a hole at the bottom and its top open. If you now reorder the throughole, 
interchanging its position with that of the hollow, the resulting solid is quite different. The result is a thin-walled 
solid with a thin tube sticking up from the bottom of the solid.

See Also
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Why Update Design can Fail
Update Design can fail due to geometric problems such as a taper angle that is too large for an extrusion, a face 
referenced by a workplane for its geometry is no longer planar, or a blend radius that is too large. Geometric 
problems can also arise if you create an invalid profile. The feature is shown in the feature tree with a  mark 
against it to indicate that there is a problem with it.

Update Design can also fail due to relational problems. An example of this is when some edges become dormant in 
a blend feature or some of the faces become dormant for the hollow feature. A dormant error is shown with a 
mark against the feature in the browser.

See Also
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About Dormant Faces and Edges
When you update a model, there may be some faces and edges without any topological and geometric data 
associated with them. In other words, these faces and edges do not exist in the regenerated model in this instance.
These entities are referred to as dormant entities. You can create dormant faces and edges by editing, suppressing,
condemning, or reordering features. 

For example, you can have a rectangular block as the base feature and a circular boss on the top face of the block. 
Next, you can blend the circular edge at the base of the boss. At this point of time, you will have three features in 
the browser – base feature, circular boss, and the blend. If you now Suppress the circular boss, the edge that you 
blended does not have any topological and geometric data associated with it anymore since the circular boss is 
suppressed. You receive an error message while regenerating the blend that objects that it depends on are 
currently dormant. If you Unsuppress the circular boss, the blend successfully regenerates as the circular edge 
“comes back to life” being associated with valid topological and geometric data.

Similarly, faces can become dormant too. In our example, if there was a workplane associated with the top circular 
planar face of the boss, after suppressing the boss the workplane cannot regenerate as the face that the workplane
reference for its geometry is dormant now.

See Also
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Moving a Sketch to a Different Workplane
You can change the workplane of the sketch by selecting Properties of the sketch and pressing the Change button. 
Subsequently you can select a workplane from the Workplane list in the Choose Workplane dialog box. The list 
contains all the workplanes that are not dependent on geometry produced by the sketch. 

You can get to the property sheet of the sketch in a number of ways. You can use the Sketches command from the 
Workplane menu in the part window and press the Properties button in the Sketches dialog box. You can also select 
the sketch in the browser view and select Properties from the popup menu. 

You might also want to copy a feature onto a different face rather than moving it, in which case you might need to 
Copy the lines of the sketch to clipboard and Paste them back onto the newly created workplane before performing 
the feature operation.

See Also
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Blending all Edges Around a Face
You can select all the edges around a face by selecting the face and using the Edges of Selected Faces from the 
Select menu. You can also box-select all edges of the face. Once all the edges are selected you can use the Blend 
Edges from the Feature menu. The selected edges should not include any smooth edges. Smooth edges can arise 
because of previous blending operations.

See Also
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Suppressing Features Within a Profile
You can have multiple closed loops in the profile as long as they are not intersecting. After placing the feature you 
can activate the sketch of the feature and toggle some of these closed loops into construction lines using the Toggle
Construction on the Line menu. Closed loops that are turned into construction lines do not participate in the 
generation of the feature anymore and you can get the effect of a feature being suppressed. To unsuppress the 
feature, you can toggle construction lines again, after selecting the lines in the closed loops. 

See Also
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Moving a Feature to a Different Face
You can create a workplane on a face by selecting the face and clicking Plane of Object on the Workplane menu.    
You can move a feature to a different face by creating a workplane on the face and moving the sketch for the 
feature to the new workplane.

See Moving a Sketch to a Different Workplane for more information.

See Also
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What is DesignWave?

Introducing DesignWave

DesignWave brings the power of parametric feature-based solid modeling, assembly modeling and feature-based 
drafting to the PC desktop as a ready-to-go productivity tool for design engineers. DesignWave offers dramatic 
gains over existing CAD technology, and marks the end of an era for 2D drafting systems for general-mechanical 
design.

With parametric feature-based solid modeling, you can create designs in less time, with fewer mistakes along the 
way. The feature-based drafting significantly enhances drawing productivity, so you can concentrate your efforts on
design, rather than documentation.

Easy to Learn and Use

There is a common perception that 3D CAD is inherently difficult to use. DesignWave demonstrates that there is 
absolutely no reason why powerful high-end CAD technology cannot be harnessed as an easy-to-use design system
on the PC desktop.

In fact, DesignWave is intuitive and discoverable. After just an hour or so of self-paced tutorial and exploration, you
will feel confident and ready to start modeling and drafting real-life objects. So you do not have to use it everyday, 
all day long, to maintain a level of expertise.

General-Mechanical Design

DesignWave is designed for general-mechanical design and drafting. That is, commonplace hunks of solid material 
connecting functional form features of a mechanical or assembly-fit nature, and assemblies of such parts. The 
majority of mechanical products, or clearly identifiable sub-systems, fall into this category. It is easy to recognize 
those parts before you start. There is nothing more infuriating than getting 90% of the way through a 3D design, 
then coming across a limitation in the software.

See Also

{button ,AL(`intro')} Other topics in this introduction



Setting Up DesignWave

Hardware

You must run DesignWave on a computer with an Intel or compatible CPU. The minimum hardware specification is 
a 90MHz Pentium with 16Mb RAM. For serious use, 32Mb RAM or more is recommended. DesignWave runs on 
Windows 95 or Windows NT v4.

You can check your processor and RAM by opening the System icon in the Control Panel.

{button Take Me There,EF(`SysDM.cpl',`System,0')}

Graphics

To run DesignWave, set your display for 16 bits of color or more (65536 colors, or high color). You can use 24 bits 
of color (true color), but DesignWave will not make use of the extra colors available. DesignWave will not work if 
the display is set for 8 bits of color (256 colors). 

The recommended desktop size is 1024x768 pixels or larger for serious use, although DesignWave will run with any
desktop size.

You can check all your display settings by opening the Display icon in the Control Panel and going to the Settings 
page. It is common for a display driver to add an extra page to this dialog, usually just before the Settings page. If 
this is the case for you, then you should use the settings on that page instead.

{button Take Me There,EF(`Desk.cpl',`Display,3')}

Printing

You can print DesignWave drawings to any raster printer or plotter. These include ink-jet, bubble-jet, and laser 
printers and plotters. Vector devices, such as pen plotters, are not supported.

See Also
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Support
If you have a web browser, you can access the DesignWave support web page by pressing this button:

{button Support Information,EF("index.htm",`',1)}

See Also
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About the User Interface

Objects

The word object is the generic term for any identifiable entity within DesignWave. Examples of objects include 
parts, solids, faces, edges, features, mating conditions, workplanes, sketches, lines, drawings, drawing views, 
dimension lines, leaders, callout groups and callouts. 

Notice that some objects have no physical presence in their own right. You cannot see a feature, although you can 
see the faces and edges that are produced as a result. You cannot see a sketch, but you can see the lines that it 
contains. Even more abstract, is a mating condition, which you certainly cannot see, although you can see that the 
component is in the right place. 

You can select objects that you can see in views or drawings. Object that you cannot see appear as icons in the 
browser, down the left side of the part window, to enable you to select them.

Object-Action

DesignWave uses an object-action paradigm. This means that you select your objects first, and then choose a 
command to operate on them. Commands on the menu are appropriate for the selected object. When the 
command has executed, the objects remain selected, ready for you to choose another command. 

Modes

You choose a selection mode for the type of object you want to select. For example, you might be selecting lines, 
selecting edges, selecting faces, or selecting annotations. The Select menu lists the different selection modes, and 
the check mark next to the menu entry indicates the active interface mode. Selection modes are also available on 
the toolbar, where the depressed button indicates the active mode.

There are other modes that are not selection modes, such as creating circles or trimming line segments. When you 
are not in a selection mode, you can press the ESCAPE key to enter the selection mode most closely related to the 
mode that you are in. So, if you are creating circles, pressing ESCAPE puts you into the mode for selecting lines. As
an alternative to pressing the ESCAPE key, you can click in the view without dragging.

See Also
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Finding Commands
The menus that you see on the menu bar depend on whether a part window or a drawing window is active. A 
window is active when its title bar is highlighted, usually in blue unless you have customized your desktop.

There are various short cuts that allow you to access commands quickly. Toolbars present graphical buttons that 
activate commands. Popup menus, displayed by clicking the right mouse button, offer a short list of common 
commands. Keyboard key combinations provide quick access to commands. These short cuts are a convenience 
and a productivity aid. You will quickly learn the short cuts that suit your style of working. 

In general, all commands can be found on menus presented in the menu bar. The exceptions to this rule are the 
commands on browser popup menus - for example, the Suppress command in the feature browser. This is because 
these commands operate on the icon in the browser, whereas menu bar commands apply to the selected objects in 
the view. So if you have trouble finding a command, perhaps that is where it is.

See Also
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The Undo Command
If you make a mistake, or change your mind about what you just did, you can choose the Undo command on the 
Edit menu to go back one step. The main toolbar also has a button for Undo and the text next to it tells you what 
will be undone if you press it.

Undo affects changes to parts and drawings, but does not affect window commands. For example, if you use Delete 
to remove a line, and then rotate the view and zoom in to make things a little larger, the text of the Undo 
command still says “Delete”. Choosing Undo will bring back your line, but the view rotation and zoom will not be 
affected.

See Also
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Using Context-Sensitive Help
DesignWave comes with extensive on-line help. The Help Topics command offers you a Contents page, an Index 
page for keyword searches, and a Find page for a full search of the help text. In addition, there is context-sensitive
help for commands, messages and dialog windows.

There are three ways to access context-sensitive help:

Enter the help mode. To do this, you can choose the Context Sensitive Help command on the Help menu, or
you can press the SHIFT-F1 key combination. You will see the cursor change to indicate that you are now in the 
help mode. In this mode, you can click on anything you can see to jump directly to help on that item. You can also 
choose a command from a menu to get help on that command.

You can press the F1 key at any time you need help about your situation. If a message window comes up, 
pressing F1 gives you further explanation of the message. If you press F1 when you have a menu displayed, you 
will get help for the highlighted command.

When a dialog window is displayed, you can press the help button at the top right of the window to enter 
the help mode. You will see the cursor change to indicate that you are now in the help mode. In this mode, you can
click on any control in the dialog window to get a popup message explaining what that control is for. Alternatively, 
you can select the What’s This? command from the popup menu when you are over the control.

When a dialog window is displayed, the context-sensitive help provided is for each dialog control in turn. For help 
on using the command that displayed that dialog window, you should press the CANCEL button to dismiss the 
dialog, press the SHIFT-F1 key combination, and then select the same command again.

See Also
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Creating Objects
To create common objects, such as lines and dimensions, you must first enter the appropriate creation mode. The 
window toolbar offers the creation modes, and the button that is depressed indicates the current mode. You create 
these objects by dragging in the window. As you drag the cursor, DesignWave shows you dynamic feedback of what
will be created when you release the mouse button. To cancel the creation, press the ESCAPE key.

Some objects use dialog window input instead of creation modes. For example, there is no creation mode for 
creating an extruded profile feature, but there is a command called Extrude Profile instead.

See Also
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Selecting Objects

Preselection Highlighting

As you move the cursor over objects in the window, the objects light up to indicate that they are selectable. If you 
are selecting lines, only lines light up. If you are selecting edges, only edges light up. This is called preselection 
highlighting and it means you know exactly what will be selected before you commit yourself to clicking the mouse 
button.

Selecting Several Objects

If you press the left mouse button down and release it, the prehighlighted object is selected and highlighted in red.
If instead, you drag the mouse while the button is down, you can box-select all those objects that lie within the 
selection rectangle that appears. 

If you hold the SHIFT key down, and press then release the mouse button without dragging, the pre-highlighted 
object is added to the selection if it is not already selected. Otherwise, it is removed from the selection. If you hold 
the SHIFT key down while box-selecting, the new objects are added to the selection, even if some of them were 
already selected.

To cancel a box-select when you are in the middle of dragging the box, press the ESCAPE key. To clear the 
selection, click on the background where there is no selectable object.

See Also
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Modifying Objects
You can modify the objects you created by dragging in the window (for example, lines and dimensions) by selecting
and dragging. Dragging from different places on the object often produces different modification behaviors. For 
example, dragging the end point of a straight line repositions that end point, whereas dragging the middle of the 
line bends the line into an arc.

See Also
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Editing Properties
Objects have properties that can be edited. A circle has a center and a radius. A dimension callout has units, 
number of decimal places, and various other properties to do with its appearance. 

To change the properties of an object, select it, then choose the Properties command from the Edit menu. You can 
also access the Properties command by double-clicking on the object. For objects that appear in the browser, such 
as sketches and features, the popup menu gives you a short cut to the Properties command for the object in the 
browser under the cursor.

See Also
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Using Viewing Commands
The viewing commands - Autoscale, Zoom In, Half Scale and Pan – allow you to change the scale and center of your 
view scene. They affect only the active window, so if you have another window displaying the same subject, that 
other window is unaffected. See Creating Additional Windows for more information. You can use viewing commands
at any time, except when a dialog window is displayed.

If a part window is active, you can also rotate the view using the arrow key accelerators. Commands are also 
offered on the View menu for this.

See Also
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Creating Additional Windows
The New Window command on the Window menu opens another window showing the same part or drawing. With 
two windows, you can look at the part or drawing in two different ways at the same time.

If you have several windows displaying the same part or drawing subject, changes made to the subject in one 
window are immediately reflected in the other windows. Likewise, the current selection is shown highlighted in all 
windows. The interaction mode is also the same for all windows. 

The viewing commands - Autoscale, Zoom In, Half Scale, and Pan - do not affect other windows displaying the same
subject. So you can have one window showing the entire subject, and another - perhaps to the side of it - zoomed 
in to show some detail. You can make selections in either window.

With two part windows displaying the same part, you can use the Shaded command on the View menu to show the 
part as a shaded image in one window, while displaying is a wire frame image in the other. You can also rotate the 
views so that each window shows the part from a different viewing direction.

See Also
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Splitting a Part Window
For part windows, you can use the Split command on the Window menu to break up the view and reveal additional 
panes. You can produce four panes by clicking within the viewing area, or two panes by clicking above, below, or 
off to one side of the window.

With four panes, the main view appears in the bottom right pane. The other three panes are linked by a 3rd angle 
projection scheme. If you zoom or pan in one of these panes, the linked panes are automatically adjusted to 
maintain the projection scheme. The top-left pane shows a plan view, the same view displayed for the main view if 
you choose the Plan command on the View menu.

With two panes, the main view moves to the right or below the new pane. The new pane shows a plan view, the 
same view displayed for the main view if you choose the Plan command on the View menu. You can zoom and pan 
the two panes independently.

Working with Split Windows

You can rotate only the main view. Although you can zoom and pan the other panes, you cannot rotate them. Since
you can work in any of the panes, you can select objects or create lines in whichever pane is the most convenient. 
You cannot create lines or otherwise use workplane points in a pane displaying a side view of the workplane.

Unsplitting a Window

To unsplit a window, you can either drag the pane dividers off the window, or you can double-click on them. 
Double-clicking on the intersection of the dividers in a four pane window returns the window to a single pane, 
Double-clicking on just one of the dividers removes that divider, producing a two-pane window.

See Also
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Setting User Options
The interaction required when creating objects in DesignWave is kept to a minimum by taking many of the inputs 
from settings that you can establish using the Options command on the Tools menu. For example, the number of 
decimal places used for all dimensions created can be set up here.

You can override these settings by using the Properties command after you have created the object.

The settings belong to you as user preferences. If someone else logs onto your computer, they will have their own 
settings.

See Also
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Saving Your Work

Parts and Drawings

You can use the Save command on the File menu to save what you are working on. The title bar of the part window
or drawing window shows the name of the part or drawing displayed in that window. If you have never saved it, the
title bar will show Part3 or Drawing3 where “3” is a number that is incremented for each new part or drawing you 
create.

An asterisk after the name, as in Bracket.cvp *, tells you that changes to the part or drawing have been made 
since it was opened. New parts and drawings have an asterisk too. When you see an asterisk, this means that the 
part or drawing needs saving. You can save it at any time or use the Close command on the File menu and discard 
the changes.

Sessions

The Save Session command on the File menu saves the entire session. When you save your session, any open parts
and drawings that have changed are saved, as well as a record of open files and window positions. You can open 
the session later and continue where you left off.

If you work on many projects, you can use sessions to represent the various projects. The name you give for the 
session can identify the project. If you only work on one project, you might simply name the session work.cvs.

See Also
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Using Measurements
Use the Measure command to determine the length, radius or diameter of an object, and the distance between two 
objects. This includes the measurement of the distance between a geometric object and the active workplane or 
work axes. 

To measure an object, choose the Measure Command on the Tools menu. Then select a measurement and choose 
the Add button to display the active measured value in the text field of the dialog. The values in the text field are 
then available on the numeric list boxes of other commands, for example, the extrude distance numeric list box.

You can invoke the calculator from the dialog to perform mathematical operations on measured values before using
them in a subsequent command.

See Also
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Tips for Working with Large Models

Minimize windows you don't need

Whenever you make changes to a model in one window, the changes are automatically displayed in any other 
drawing and assembly windows in which that model can be seen. If you have many windows open with complex 
parts or drawings, the time needed to update the windows can be significant. Minimized windows and windows 
hidden behind a maximized window are skipped during window update. So, when working with large models or 
with lots of models simultaneously, either minimize unused windows, or maximize the window you are working in 
to improve performance. The changes you make will be applied as a batch when the window is revealed later.

Suppress features that are not important for the time being

You can use the Suppress command on the popup menu inside the feature browser to take selected features out of 
service. While features are suppressed, Update Design takes less time since there are fewer features to process. 
Later, you can deselect the Suppress command to return the features to service.

 Build a large model in stages

Each time you make a change to a model, the model regenerates from scratch. You can avoid this by creating a 
new part and using the Add Component command on the Assembly menu as a means of check-pointing your design
at a meaningful state. 

Create your model and, at a good breaking point, save it. Now create a second part and use the Add Component 
command on the Assembly menu to add the basic design part as a component. There is no need to position the 
component in any way. Choose the Use Component command on the Feature menu to turn the component into a 
derived model that you can develop further. 

Now you can add the detail features to the second part. Changes to the second part will only regenerate from the 
state of the model as it was brought in through Add Component. Changes to the original part can be effected into 
the second part using Update Design on the modeling toolbar. 

See Also
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Importing and Exporting Parts
Importing and exporting parts allows you to save parts in formats that can be used by other applications. You can 
import and export a model in Parasolid™ transmit file format and output in VRML format. You export a model in 
Parasolid™ or VRML format using the Save Copy or Save As VRML commands, respectively, from the File menu. You 
can import a Parasolid™ transmit file using the Open command from the File menu. An existing Parasolid transmit 
file must be specified as the input.

The ability to import and export models in Parasolid™ format allows you to share models with an application that 
supports the Parasolid™ transmit file format. The Import command allows you to read in another modeler's 
Parasolid™ transmit file and use it in advanced DesignWave environments. You can read in a model to add more 
features to it, produce a drawing from it, or use it in an assembly. The exporting of a DesignWave model in 
Parasolid™ transmit file allows you to work with your model in other applications. This would include other 
Parasolid™ based modelers as well as other applications, such as translators, that take the Parasolid transmit file 
format as input.

DesignWave provides fully automatic output of solids and assemblies in VRML V1.0 format. This allows you to build 
virtual worlds, or share virtual mockups over the company intranet, or perhaps even with customers over the 
Internet. You can view DesignWave parts with your favorite VRML viewer to produce marketing quality pictures.

There are three basic types of VRML viewer:

Browser plug-ins - browser extensions designed to handle a particular data type for which the browser has
no native support. A plug-in runs as if it is part of the browser itself. 

Separate viewer applications - A separate VRML viewer application is a program that reads VRML files and 
displays objects, allowing you to manipulate them, and perhaps modify their properties.

Virtual world navigators - Virtual world navigators are the 3D space equivalent of 2D page-oriented web 
browsers. They display VRML world scenes, and let you move within them.

See Also
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Introduction to Sketching
All lines that you create live in sketches, which belong to workplanes or drawings.

A sketch can contain any number of lines. A line can be a straight line, an arc, or a circle. You use sketches to 
describe a profile to be used when creating a feature. Sketches are also used to define the cut when creating a 
section view on a drawing and a clipping profile when creating a partial view. Commands that use sketches as input
often have rules that must apply to the lines in the sketch for that sketch to be valid.

The Active Sketch

When you create a new line, it is automatically added to the active sketch. You can change the active sketch at any
time by using the Sketches command on the Workplane menu for a part window or on the Drawing menu for a 
drawing window. You can also use the Activate command on the popup menu whenever you can see the sketch in 
the browser view.

Naming Sketches

Sketches have names. The name is used whenever the sketch is shown in the browser view. Although the system 
generates a default name, such as “sketch 3”, it is good to rename your sketch with a name that captures the 
intended use of the sketch. You can name the sketch when you create it or later by editing the properties of the 
sketch.

Hiding Sketches

The Sketches command also allows you to hide sketches. This de-clutters your view, and also stops points from 
lines in other sketches being inadvertently selected as you create new lines in the active sketch.

See Also
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Using the Work Axes
Each workplane has a pair of work axes that defines a 2D (x,y) coordinate system for the workplane. Although the 
lines you create in sketches are 3D lines, they are described in terms of 2D coordinates in the workplane. 
DesignWave never asks you to enter a (x,y,z) coordinate.

The work axes belong to the workplane, not the active sketch. If you activate another sketch in the same 
workplane, the work axes are the same. The work axes of another workplane generally have a different position 
and orientation.

The work axes are yours to move around and orient. You can move and orient the work axes using the Reposition 
Axes command. You can also use the Transform Axes command to translate or rotate them by a specific amount.

Local Coordinate System

When you see (x,y) points displayed in the dialog bar, these are always relative to the work axes. Similarly, when 
you use the Properties command to examine or modify the geometry of a line, the 2D points shown in the dialog 
window are relative to the work axes.

Local Set Square

When creating straight lines, if you hold the SHIFT key down, the line snaps to the closest of the two work axes 
directions. This provides a quick and easy way for you to lay down parallel and perpendicular lines. See Creating 
Lines for more information.

See Also
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Selecting Existing Points

Attraction Points

Whenever you are invited to select points in the active workplane, existing points are pre-highlighted as black 
squares as you move the cursor over them. These are called attraction points. Large black squares indicate precise 
points: end-points, mid-points, intersection points, and centers of circles or arcs. Small black squares indicate a 
point on the line close to the cursor.

Circles and Arcs

For circles and arcs, if the cursor is slightly on the inside of the line, the center point is offered. If the cursor is 
slightly outside the line, the point on the circumference is offered. When creating straight lines, a point on the 
circumference is interpreted as a tangent – see Creating Lines for more information.

See Also
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Selecting Grid Points
When you select a point that is not an attraction point, DesignWave snaps it to an invisible grid so that you get 
sensible values for X and Y. The grid is completely automatic, so you do not need to manually set a grid size 
anywhere. DesignWave selects a grid size based on the zoom factor of the view or drawing. To get a finer grid, just 
choose Zoom In from the popup menu on the right mouse button. To get a coarser grid, choose Half Scale instead.

How the Grid Works

First of all, DesignWave looks to see what units you are working in. You can set the units using the Options 
command on the Tools menu, and going to the Units page. For part windows, the units for model distances are 
used. For drawing windows, the units for paper distances are used. 

Then DesignWave determines a grid size based on these units and using a multiplier of 1, 2, or 5 with some power 
of ten. For example, if you are working in centimeters, you get grid sizes from the following series:

... 0.01cm, 0.02cm, 0.05cm, 0.1cm, 0.2cm, 0.5cm, 1cm, 2cm, 5cm, 10cm, ...

whereas if you are working in inches, you get grid sizes from this series instead:

... 0.01in, 0.02in, 0.05in, 0.1in, 0.2in, 0.5in, 1in, 2in, 5in, 10in, ...

The grid size DesignWave chooses is the finest one from the series that can be used effectively to select grid points
easily using freehand movement of the mouse. The grid size is about 3 pixels on the screen.
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Creating Lines

Creating Straight Lines

You create straight lines by choosing the Straight command from the Line menu. This puts DesignWave into an 
interface mode in which you can create straight lines just by dragging in the workplane. As you move the cursor 
around in the view, DesignWave prehighlights lines and also offers attraction points for end-points, mid-points, 
centers, and intersection points involving those lines, so you can use these points directly. See Selecting Existing 
Points for more on attraction points. 

To create a straight line, press the left mouse button down for the start point, drag to the end point, and release 
the button. Attraction points and grid points are offered while you are dragging too, so you can select a precise 
end-point for your line. If you hold the SHIFT key down while dragging, DesignWave constrains the line so as to lie 
parallel to the closest work axis direction. You can still select from points off this line, and DesignWave will project 
points onto the line.

Creating Tangent Lines

As a special case for creating straight lines only, DesignWave interprets selecting an attraction point on the 
circumference of a circle or circular arc as a tangency requirement. You can select a point on the circumference by 
placing the cursor close to, but just outside, the line. Placing the cursor just inside a circular line selects the center 
point. As you drag away from the circular line, DesignWave gives you dynamic feedback of the tangent line. If you 
drag towards another circular line, again just outside it, the end point is tangent.

If you want to use a point on the circumference directly, and not have DesignWave infer a tangency requirement, 
you can create a line that cuts across the circumference first, then select the intersection point produced. 
DesignWave interprets intersection points and end-points as a stronger requirement than tangency.
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Using Construction Lines
Construction lines in a sketch are used for a number of reasons. In case of modeling, construction lines in the 
sketch are ignored as far as the profile definition is concerned. This allows you to use construction lines freely to 
define the underlying profile for a feature. When defining the cut line for a section view, a construction line is used 
to indicate the principal section line and which side of it to generate the section view. Construction lines will not 
appear when you print the drawing.
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Modifying Lines

Modifying Straight Lines

To modify a straight line, you must first select it. You can select lines by choosing the Lines command from the 
Select menu. If you are currently in another interface mode for lines - such as creating straights, deleting 
segments, or filleting lines - you can press the ESCAPE key instead.

The following modifications are possible by dragging parts of the line:

Dragging an end-point repositions that end-point. 
Dragging from near the mid-point bends a straight line into a circular arc that passes through the point at 

which you release the mouse button. This provides you with an “arc through 3 points” construction.
Dragging an end-point with the SHIFT key held down extends or shortens the line, while maintaining its 

underlying geometric form. As you drag, you can select points away from the line, and DesignWave will project 
them perpendicularly to the line. If you drag to a point on another line that is not an end point or mid-point, the 
line being modified is extended to intersect with that other line.

To move a line, you should use either the Transform command or Shift Point-to-Point command, which are on the 
Edit menu.

Editing Line Properties

You can change line properties by selecting a line from the sketch and using the Properties command on the Edit 
menu. As an alternative you can also double-click on the line to display the Properties dialog window.
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Editing Line Geometry
You can modify line geometry in several ways. One way is to modify it using the Properties dialog box. To 
interactively edit the line geometry, drag one of its endpoints to the desired location. You can also bend a straight 
line into an arc by pulling it from the middle. Different cursors indicate the intent of the modification.
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Using the Clipboard with Lines
You can use the clipboard commands - Copy, Cut, and Paste - on the Edit menu to move or copy lines. When lines 
are placed on the clipboard using Copy or Cut, DesignWave makes a note of the where the work axes are. When 
you Paste the lines, they are added to the active sketch in the same place relative to the current work axes.

This allows you to do several things:

You can copy lines from another sketch, even one from another part. Perhaps you are designing a part that has a 
face that will bolt to a similar face in a mating part. You can Copy the lines you want from the profile sketch in the 
mating part, and Paste them into the sketch you are working on.

You can move lines to a different sketch. Perhaps you have created several lines, and then you suddenly realize the
wrong sketch is active. Just select and Cut the lines, then activate the correct sketch and Paste the lines into it.

You can reposition lines by repositioning the work axes. For example, you can move a 2D feature in your profile, 
such as a keyhole, to some new place with a new orientation. First, you place the work axes to represent a local 
origin and orientation for the 2D feature. Next, you select and Cut the lines. Then, you reposition the work axes, 
and Paste the lines into their new position. The topic Using the Work Axes describes various ways to position the 
work axes.

You can produce copies of lines in different positions in the same sketch. This gives a convenient means to create 
pattern of features. The Duplicate command under the Edit menu gives you the flexibility to create rectangular or 
circular patterns of sketches.

You can produce mirror images of lines by reversing the work axes before you Paste. Use this technique to make 
symmetric profiles.
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Pasting Line Properties
You can copy and paste line properties onto other lines. Use this technique to create colinear lines, concentric arcs 
and circles, or equal length/radii segments.
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Using Existing Model Geometry
Sketch geometry can reference existing model entities. To find the attraction points of model edges, turn the Edges
check box on. The system highlights the endpoints and mid-points of edges.
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Fixing Sketches
Depending on what the sketch is to be used for, there are often rules about what constitutes a valid sketch. In 
particular, there are rules that must apply for a sketch to be a valid profile for feature modeling – see About Profiles
for details. And there are rules that must apply for valid section cut sketches – see About Section Views for details.

There are some techniques for examining and fixing sketches that are invalid. See the following topics:

Checking Connectivity.
Finding Gaps Between Lines.
Dealing With Overlapping Lines.
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Checking Connectivity
Some sketches are not valid for feature operations because they do not form closed profiles. You can check the 
connectivity of a sketch by selecting a line segment and using the Add Connected Lines from the Select menu. Any 
lines in the sketch    not picked up by this command are not connected.

Note: It is perfectly valid to have unconnected construction lines.

See Fixing Sketches for related information.
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Finding Gaps Between Lines
Sometimes sketches that look connected may not be, due to gaps between lines. To find the gaps, use the Fillet 
Lines command under the Line menu. Use a random fillet radius to examine all the corners. If, at a corner, the lines
that form the corner do not highlight, you have located a gap between lines. Use the Zoom In command to explore 
the corner further. Then fix the gap by connecting the two lines by dragging one of them or modifying them 
explicitly using the Properties pages.

The topic Modifying Lines describes various ways to modify lines.

See Fixing Sketches for related information.
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Dealing With Overlapping Lines
Sometimes sketches are invalid profiles because they contain overlapping line segments. An easy way to determine
the stray lines is to use Select Lines command and manually select all the lines that form the valid profile. Do not 
use Add Connected Lines, since it might pick up overlapping lines that are completely identical. Once the lines have 
been selected, use the Transform command from the Edit menu and Rotate the selection by 15 degrees. Then 
refresh the screen by using any view command such as Autoscale (or any of the arrow keys). If you find stray 
geometry, delete it. Then use the Select All command followed by Transform and give a negative -15 degrees 
rotation to get back to your original geometric location.

See Fixing Sketches for related information.
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Managing Your Sketches
You can manage sketches by using the Sketches command under the Workplane menu. A dialog box appears, listing
all the sketches in the active part. Use this dialog to activate a particular sketch, delete a sketch, or change the 
properties of a sketch. You can also use the Hide Other Sketches command to reduce the screen clutter.

About the active sketch:

Newly created lines are added to the active sketch.
Construction lines are visible.
All lines in the sketch are selectable.
Attraction points involving lines are selectable.

About visible sketches other than the active sketch:

Construction lines are not visible.
Lines in the sketch are not selectable.
Attraction points involving lines are selectable.

About invisible sketches:

No lines in the sketch are shown.
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Deleting Unused Sketches
You can delete a sketch that is not being used for any feature or section view by examining the number of times it 
has been used. To do this, use the Sketches command from the Workplane menu. The Delete button on the 
Sketches dialog is active only if the sketch is not being used. To find out how many times a particular sketch has 
been referenced, click on the sketch name and get its Properties. The properties dialog shows its number of uses.
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{button ,AL(`sketching')} Other topics on sketching



This is before the first topic, so it will not get displayed

Notes can go here.



Concurrent Design with DesignWave

Concurrent Design

DesignWave supports concurrent design through its implementation of inter-file references and search paths. By 
straightforward use of the directory structure, you can support an environment where a design evolves while 
respecting the concepts of an ECO and approval process. This brings you an environment that supports team-based
design and the concurrent development of a product.

With concurrent design, you can work on the drawing of a model at the same time a colleague is changing the part 
model. While your session is active and the models that it references are loaded, you are insulated from changes 
made to those models. The next time you open the drawing, you can choose the Update Views command on the 
Drawing toolbar to update your drawing to reflect changes made to the parts displayed. This process is identical for 
assemblies, as well as parts.

Concurrent Design Scenario

Imagine you have several people working as a team on the design of a product. In addition to creating parts at the 
same time, team members can also produce the drawings required to manufacture the parts. Early in the project, 
team members are working individually in their own private directories and do not see the work of their colleagues.

When a part or drawing is complete, you move it to a common “product” directory on the network. This common 
directory is in the search path of each team member, as specified with the Options command on the Tools menu. 
When a part or drawing is in this common area, the other members of the team can see it.

Assembling of the parts can begin at any time after multiple parts have been checked in. After you have added all 
of the parts to the assembly, you can add the assembly to the shared directory. This provides all members of the 
team access to the assembly. 

In the meantime, you can respond to an ECO on your part by copying it back to your local private directory and 
working on it. Changes will not affect the shared design. When you are satisfied with your changes, you can submit
your part to an approval process. Your team members can copy your part to their local directory to see your 
changes, or add your private directory ahead of the shared product directory in the Search Path. Once approved, 
you move your part to the shared directory, and all other parts and drawings can be updated to reflect your 
changes.
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Sharing Information

Inter-File References

When you add a view to a drawing, DesignWave creates a reference to the part file. The same is true when you add
a component to an assembly.

You can share files with your team members by defining a common directory on the network for product parts and 
drawings. You use this shared “product” directory as the set of approved files for a project that you are working on 
collaboratively. Each team member would also have a private local directory for making changes. By working in a 
local private directory, your changes would not affect any of the other accepted product parts and drawings. Once 
you are satisfied with your changes, you move them to the shared directory on the network. This makes your 
changes visible to all of the approved parts and drawings, and they can be updated to reflect your changes.

By adding the shared “product” directory to each the team member’s search path, the team member has access to 
all of the parts and drawings related to the product. This reduces the amount of copied parts and drawings, as well 
as the potential logistical problem of keeping them up-to-date and synchronized.

File Locking

DesignWave does not support file locking. This means that if several people have copied a part to their local 
directory, the last person to move the part back into the shared “product” directory overwrites the other changes. 
Only the last team member's changes will be reflected in the accepted design.

Check Out and Check In

You can avoid problems by using the read/write privileges of file system to control concurrent access to a file. A 
team member who copies a file to the local directory should change the access privileges to read-only on the 
common part. In this way, another team member who copies the part is notified that changes cannot be written 
because the part is read-only. You can adopt the practice of checking the permissions of the file as part of the 
process of copying it to a local directory, which provides the team with a mechanism for knowing when another 
team member is currently working on a file.
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Using Search Paths

Search Path

When you open an assembly or drawing, other files that are referenced are loaded automatically. You are at liberty 
to move files around on your disk. As a consequence, a referenced file may no longer be found in the pathname 
that it was known to be in at the time the assembly or drawing was saved. When locating referenced files, if they 
have moved, the directory search path is examined in order to locate the file.

You can set up your search path using the Options command from the Tools menu. On the Directories page you can
list the folders to be searched in order when locating files. Your search path is remembered between sessions.

Finding Files

When a file has to be resolved, it is looked for in the following places, in order:

1 At the pathname know at the time the assembly or drawing was saved.

2 In the same directory as the referencing assembly or drawing.

3 In each of the directories listed in the search path in turn.

If the file still cannot be found, you are prompted proceed assuming the file is deleted, or to cancel the open.
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Understanding Versions

File Versions

Each time you save a part or drawing, an internal version number is incremented for that file. If an assembly or 
drawing is opened, and a referenced file is found to have a different version number, update occurs automatically 
to reflect any changes made between those versions. 

The version will typically have increased, but by using search paths, it is possible to encounter an earlier version of 
the file. Update will still occur automatically.

A Warning about Version Branching

If two people take a root version of a file and start independently producing higher versions as two separate 
branches, you should note carefully that files from one branch are incompatible with files from the other branch. If 
you save an assembly using a part file version from one branch, you must ensure that your search path will not 
allow a version from the other branch to be loaded. Otherwise errors will occur and parts could get corrupted.

Version branching in this way is not recommended. If you want to evaluate alternative designs, you should use 
derived models instead. See Using Derived Models to Capture a Process for details.
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